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Thank you for choosing Sennheiser!

We have designed these products to give you reliable operation over many
years. Over half a century of accumulated expertise in the design and
manufacture of high-quality electro-acoustic equipment have made
Sennheiser a world-leading company in this field.

Please take a few moments to read these instructions carefully, as we want
you to enjoy your new Sennheiser products quickly and to the fullest.
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Important information on this manual

Important information on this manual

This manual describes five different software modules which work closely
together. The words and pictures in this manual refer to the entire range
of functions offered by all five software modules. If you do not have
licenses for all five software modules, some of the functions described here
and some of the buttons, menus etc. shown here will be missing from your
software. You then cannot use these functions.

For information on the different conference modes and the selectable
modes between or within interpreter booths as well as the SDC 8200
consoles, please refer to the SDC 8200 system manual.

Safety instructions

PC files can be destroyed by defective hardware (e.g. hard disk crash,
defective boot sectors), by software (e.g. PC viruses, hard disk
partitioning programs etc.) or by magnetic fields (e.g. from unscreened
loudspeakers)! Persons not trained in handling PCs can change, make
unuseable or delete PC files by mistake.

Restrict access to your SDC 8200 system PCs to absolutely trustworthy
persons who know how to handle them! Install trustworthy software
only or check software with an up-to-date virus scan program before
installing it!

Protect these PCs via a firewall a virus scan program! Have an
expert set the parameters of the firewall to the highest security level!
Have the firewall and its settings checked from time to time and have
it adapted to new situations! Update your virus scan program as often
as possible!

Make a backup of all data in your SDC 8200 installation on removable
storage media (e.g. floppy disk) whenever you create or change an
installation! Keep the removable storage media in a safe and protected
place!

Delivery includes

e 1 SDC 8200 SYS software on CD
* 1dongle
¢ 1 software manual as PDF on CD

In addition, you require one or two zero modem cables.
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Getting to know the software

Important features of the software

The SDC 8200 SYS software makes your SDC 8200 conference and
interpretation system more convenient to operate and adds additional
functions according to your requirements. The software:

* allows you to quickly and easily configure the conference system:
All parameters of your conference consoles can be easily configured
from a central point.

allows you to adapt the configuration even during a conference:
You can change certain parameters without interrupting the conference.

gives you a better overview of your conference:
You — and all delegates if you so wish — can see at a glance which
consoles are currently active.

is a powerful tool for managing your delegate data.
You can access delegate data at any time.

gives your conference a personal touch:
You — and all delegates if you so wish — can see the name of the current
speaker.

allows you to directly control all consoles:
You can activate or deactivate the microphones by a mouse click.

makes it especially easy to take votes and display the results, for
example using a projector or a large screen.

improves voting security:
You can use the chip cards to authenticate the delegates.

makes the interpretation system easy to configure:
All parameters of your interpreter consoles can be easily configured
from a central point.

allows you to adapt the configuration of the interpretation system even
during a conference:

You can change modes between or within interpreter booths, Autofloor
and other parameters at any time without interrupting the conference.

allows you to monitor the status of the interpreter consoles during the
conference.

Different licenses for the software modules providing the functions you
require are available from Sennheiser electronic.
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The software modules

Sennheiser provides two different software packages which add different
functionalities to the SDC 8200 conference and interpretation system:

An SDC 8200 conference and interpretation system consisting of one
SDC 8200 central unit with up to 50 conference consoles is only
partly configurable. The interpretation capacity of the SDC 8200 CU-M
central unit is four languages.

For PC controlling this system, you require the SCD 8200
software. Additional software modules or licenses to expand the
functionality are not available.

An SDC 8200 conference and interpretation system consisting of one
or several interconnected SDC 8200 CU central units and up to 1024
conference consoles is fully configurable. The interpretation capacity of
the SDC 8200 CU central unit is 28 languages.

For PC controlling this system, you require the modular SCD 8200
software package which can be expanded with different SDC 8200 S
software modules (see “Accessories” on page 112).

Please note that the SDC 8200 SYS software cannot be used with the
SDC 8200 CU-M central unit, and that the SCD 8200 SYS-M software
cannot be used with the SDC 8200 CU central unit.

For information on the two central units, see “Features of the central
units” on page 117 of the SDC 8200 system manual.

The SDC 8200 SYS-M software

The SDC 8200 software only works with the SDC 8200 central
unit.
This SDC 8200 software does not have all the functions descibed in

this manual but is otherwise identical to the SDC 8200 SYS software, which
is described in the following chapter.

The SDC 8200 SYS-M has the following restrictions:

* The synoptic view can only comprise a maximum of 50 initialized
conference console icons.

* The voting mode "1 of 5" is not available. You can only use the voting
mode “1 of 3".

The following chip card functions cannot be used:
* Data from the delegate database cannot be written to the chip cards.
* Chip cards cannot be read.

* You cannot limit voting to owners of a chip card.
* The interpretation system can manage up to four languages.

* The interpretation system can only be configured for two interpreters
per interpreter booth.

* For network operation, you can configure one master, one slave and one
video PC.
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The SDC 8200 SYS software

The SDC 8200 SYS software only works with the SDC 8200 CU central unit.
The software consists of two programs:

* “Confsys” for controlling the conference system and
* “IntSys" for controlling the interpretation system.

The “Confsys"” program consists of up to four different software modules
(S-MM, S-DM, S-VM, S-VD) which work closely together; the “IntSys”
program consists of one single software module (S-IM).

Each module provides a number of interrelated functions and adds
buttons, menus and windows to the program. You need a separate license
for each software module. This means that, if you do not need some of the
modules and have not licensed them, a number of the buttons, menus etc.
described in this manual will be missing from your software.

Program S-CM \ Confsys S-IM \ IntSys
for controlling the for controlling the
conference system interpretation system

Software

module

Overview of the five software modules

The S-MM software module is the basic software you require in order to
configure, monitor and control the conference system from your PC. With
the S-MM software module, you can:

* create a synoptic view of the conference room,

* assign a real microphone to each conference console icon in the synoptic
view,

* activate and decative the microphones by a mouse click,

* monitor the status of the consoles (request to speak, faulty connection,
active microphone),

* configure all parameters of the conference system.

The S-DM software module allows you to manage the delegate data and
display the names of the delegates during the conference. You can activate
or deactivate the microphone of a certain delegate by clicking his name
with the mouse.

For this, you also need the S-MM software module.

The S-VM software module allows you to take votes and program and read
the chip cards.

For this, you also need the S-MM software module.
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Hit CR to abort:

x|

Mo key Found. Mount key and try again,

Waiting for master...

Options |

Cloze

The S-VD software module allows you to display voting results as bar or pie
diagrams, for example using a projector or several large screens in the
conference room.

For this, you also need the S-MM and S-VM software modules.

The IM software module is the software you require in order to configure,
monitor and control the interpretation system from your PC. With the
IM software module, you can:

* configure all parameters of the interpretation system,

* operate the interpretation system and monitor the status of the
interpreter consoles,

* send short text messages to the interpreters.

The licenses

When purchasing the software, you also purchase licenses for one or
several software modules. All licensed software modules are activated
automatically when you install the software.

You can upgrade your license(s) at any time to include additional software
modules (see “Upgrading the software license” on page 109).

If you license additional software modules, the corresponding menus
and buttons appear automatically. Please note that the menus and
buttons of all software modules are shown in this manual — including
those for which you have possibly no license.

The dongle

When purchasing the software, you also receive a dongle (hardware
license key). This dongle releases all licensed software modules for use on
all PCs in your network and must therefore be inserted into a free USB port
(or parallel port) of the master PC.

If the dongle is not inserted at startup, the “Hit CR to abort” dialog box
opens (see “Starting the “Confsys”program for the first time” on
page 18).

If the dongle is inserted but cannot be detected due to the program
configuration, the “Waiting for master...” dialog box opens (see “Setting
the correct starting options” on page 19).

11
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The two passwords

Access to the software and the configurations is protected by two
passwords. Password 1 is required for general use and configuration of the
software. It must be entered whenever you start the software and click any
item on the menu. Password 2 is required for configuring critical software
and hardware parameters. It must be entered whenever an especially
important parameter is to be changed.

On delivery of the software, password 1 is: “123".

Password 2 is: “456".

In order to ensure that only authorized persons can access the settings
of your conference and interpretation system, these passwords must
be changed as soon as possible (see “Changing the passwords of the
"“Confsys” program” on page 21)!
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System requirements

Hardware required

Processor: Intel Pentium 4 or AMD Athlon XP, 2 GHz or more
RAM: 256 MB min. (512 MB recommended)

Hard disk: min. 30 MB free hard disk memory

Drives: CD ROM or DVD ROM drive

drive for data backup (e.g. floppy disk drive,
CD recorder or ZIP drive)

Interfaces: at least one free RS 232 interface (see note below)
Sound card: quality stereo sound card

Screen resolution: exactly 1024 X 768 pixels (see note below)
Network: optional 10/100/1000 Base Ethernet

You only require one free RS 232 interface per PCif;

* you only control conference consoles via the software and not
interpreter consoles (you have not licensed the S-IM software
module),

* you use two different PCs to control the conference and
interpretation system (each PC has an RS 232 interface of its own),

* you use only one PC to control both the conference system and the
interpretation system and have to change the interface via which the
PCis connected to the central unit (the COM 3 interface of the central
unit to control the conference system and the COM 1 interface to
control the interpretation system).

You require two free RS 232 interfaces if:

* you want to use only one PC to control both the conference system
and the interpretation system without having to constantly change
the interface via which the PC is connected to the central unit.

We recommend setting your screen resolution to exactly 1024 X 768
pixels!

13
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System requirements

The operating system required

The SDC 8200 software requires Windows 2000 or Windows XP.

Both programs (“Confsys” to control the conference system and
“IntSys” to control the interpretation system) require one COM
port each (RS 232 interface)! The SDC 8200 software therefore does

function on PCs which do not have at least one free COM port not

assigned to another software — e.g. Hotsync (software for data transfer
between a PC and a Palm PDA)!

The network

You can install the software on up to eight PCs in a network. One of these
PCs must be configured as the “master” (see “Configuring the PC in a
network” on page 44). The master PC gives you access to all functions of

the conference and interpretation system. The dongle must be inserted
into a free USB port of the master PC.

Up to two PCs can be configured as “slaves” (see “Configuring the PCin a

network” on page 44). A slave PCalso gives you access to all functions. The
slave PCs do not require a dongle.

Up to five PCs can be configured as “video PCs” (see “Configuring the PCin
a network” on page 44). A video PC does not give you access to the
functions of the conference and interpretation system. Projectors or
monitors connected to the video PCs are only for displaying data to the
delegates or guests. The video PCs do not require a dongle either.

—a
Master | |=||LDong'e
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Preparing the conference system for use

Connecting the PC to the central unit

Please note that the program for controlling the conference system and
the program for controlling the interpretation system require a separate
RS 232 interface each. Therefore, there are the following possibilities for
PC controlling your conference and interpretation system:

You connect a single PC to the central unit:

The PC has two free RS 232 interfaces. Both the program for
controlling the conference system and the program for controlling the
interpretation system are installed on this PC.

Additional slave or video PCs can be connected to the PC's network
card via a local network (LAN).

You connect two PCs to the central unit:

The program for controlling the conference system and the program for
controlling the interpretation system are installed on two different PCs.
Each PC has a free RS 232 interface.

Your PC has only one free RS 232 interface:
You connect the PC to the central unit and first configure the
conference system and then the interpretation system.

To connect PCs to the central unit:

Make sure that the required serial interfaces are available and free. The
required interfaces must appear in the Windows Device Manager under

"Ports (COM & LPT)". These interfaces be used by any other
software.
T i iiiaooiie Use one zero modem cable to connect the serial interface of the PC via
O e e’ Ta” T T GD which the conference system is to be controlled to the COM 3
interface @ of the central unit.
o Use the second zero modem cable to connect the serial interface of the
© PC via which the interpretation system is to be controlled to the COM 1

interface @ of the central unit.

After you have connected the PC to the central unit, your conference
and interpretation system can be controlled via both the PC and the
central unit!

In order to avoid inconsistencies, please make sure that no parameters
are changed on the central unit!

15
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Installing the software

To install the software on your PC or on different PCs in your network,
proceed as follows:

If you want to install a newer version of the software, you first have to
remove the old version!

Make sure that your Windows user account has administrator
privileges.

Insert the software CD into the CD ROM drive of your PC and click the
“setup.exe” icon.
The Wizard starts and guides you through the installation process.

Follow the instructions of the Wizard.

CTITEE— - If you want to install all licensed software modules on a single PC, select
Cheoe e S o3 a— “Complete” under “Setup Type”; if you want to install the program for

DD controlling the conference system and the program for controlling the
interpretation system on two different PCs, select “Custom” under
“Setup Type" and then select the program to be installed.

If you want to install the software on several slave PCs or video PCs, it
is sufficient to install the “Key Driver” (dongle driver) exclusively on
the master PC.

SDCRN0 Sabnn
LCordetence Management

After you have entered all information requested and started the
installation by clicking “Finish”, the desired software is installed on the
PC.

(i Sy D 5411 3288) - ik Wit E When the software is installed, the dongle driver (Rainbow
Erady to lerlall the Program . . . . . .
Technologies Sentinel System Driver) is installed automatically. For
SRt o b this, however, it is vital that no dongle is connected to the PC!

dhangs oy of i chch Backh, Click Cancelto

The wizard b ready bo begn nstalaton.

st tha rizwed.

IPORTANT:

During the installation of the dongle driver, you can select either
“Complete” (all components including the help file) or “Custom”
(optionally without help file). We recommend selecting “Complete”.

<ged [ pwal | e

After the installation is successfully completed, the newly installed
“SDC 8200" program group appears under “Start/Programs”. In the
"S_CM" subgroup, you will find the “Confsys"” program for controlling
the conference system (see "Preparing the conference system for use”
on page 15); in the “S_IM" subgroup, you will find the “IntSys”
program for controlling the interpretation system (see “Configuring
the interpretation system” on page 92). In addition, you will find the
"Field Exchange Utility” utility program for upgrading your license (see
"“Upgrading the software license” on page 109).

16
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Removing the software

To remove the software from the hard disk of a PC:

In the “Control Panel” window, click the “Add/Remove Programs' icon.
The “Add/Remove Programs” dialog box opens.

On the left-hand side of the dialog box, click “Change or Remove
Programs”.

Select “SDC8200" in the list and click the “Change/Remove"” button.
A warning appears. Confirm the warning with “Yes". The software is
removed from the PC.

Select “Sentinel System Driver” in the list and click the “Change/
Remove” button.

A warning appears. Confirm the warning with “Yes". The dongle driver
is removed from the PC.

17
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Starting the “Confsys”program for the
first time

When you start the “Confsys” program for the first time, the necessary
options for your PC or your network are not yet set.

Make sure that your Windows user account has administrator
privileges.

If the dongle is not inserted at startup or if it is removed during operation,
the “Hit CR to abort” dialog box opens.

In the “Hit CR to abort” dialog box, click “OK".
The “Waiting for master..."” dialog box opens.

If the PC is configured as a video PC or slave PC and does not detect the
dongle at startup (because the master PCis turned off or the dongle is
not inserted into a free USB port of the master PC), the “Waiting for
master...” dialog box also opens.

The “Waiting for master...” dialog box offers you the following options:

You can close the “Waiting for master..."” dialog box, insert the dongle
and restart the program (see “Connecting the dongle” on page 18).

You can click the "Options” button (password required!) and configure
the PC as a video PC or slave PC (see “Setting the correct starting
options” on page 19). To do so, you have to enter the TCP/IP address of
the master PC.

You then have to restart the program. The program searches for the
master PC with the inserted dongle. If the dongle is inserted into a free
USB port of the master PC and the master PC is turned on and the
program is running on the master PC, the program starts with the
selected configuration (video PC or slave PC).

You can start the program in demo mode (see “Starting the program in
demo mode” on page 20).

Connecting the dongle

To close the “Waiting for master..."” dialog box:

Click the “Close” button.
The “Waiting for master...” dialog box closes.

Insert the dongle into a free USB port of the master PC.

Restart the program.
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Setting the correct starting options

When you start the program for the first time, the “Waiting for master...”
dialog box appears and you have to decide whether the PC is to be
configured as a master PC, slave PC or video PC.

Waiting for master...

— Qemo == — T |

To do so, proceed as follows:

Make sure that all PCs on which you have installed the software are
turned on and that the dongle is inserted into a free USB port of the
master PC.

Make sure that “Full Control” is enabled for the installation folder (e.g.
C:\Programs\SDC8200) of the master PC

In the “Waiting for master...” dialog box, click the “Options” button.
The “Options” window opens.

On the “Confsys” tab, configure the PC as a master PC, slave PC or video
PC as required (see “Configuring the PC in a network” on page 44). On
the master PC and on all other PCs in the network, enter the correct IP
addresses of all PCs involved in the control of your conference and
interpretation system.

If you only use one PC to control the conference and interpretation
system, configure this one as the master PC. In this case, you do not
require any IP addresses.

On the “CU” tab, set the correct COM port (see “Configuring the COM
port” on page 49).

In the "Options” window, click the "“Save and Exit” button. The
"Options” window closes.

In the “Waiting for master..."” dialog box, click the close “Close” button.
The dialog box closes.

Restart the program. If you want to configure additional slave or video
PCs, proceed in the same way.

If the “Waiting for master..."” dialog box appears when the program is
started for the second time (or later), this means that no connection can
be established with the master PC because:

¢ the master PC is not turned on or

* the “Confsys” program is not running on the master PC or

* “Full Control” is not enabled for the installation folder (e.g.
C:\Programs\SDC8200) of the master PC or

* the wrong IP address for the master PC was specified on the video or
slave PC or

* the wrong IP address for the video or slave PC was specified on the
master PC.

See also “If problems occur...” on page 111.
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Waiting for master...

Demo ¢

Dptionz

Close
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Starting the program in demo mode

To start the Confsys program without a dongle:

In the “Waiting for master..."” dialog box, click the “Demo” button.
The program starts in demo mode.

Demo mode is started automatically when the dongle is removed
during operation.

In demo mode, your conference system is restricted to five delegates
and your interpretation system is restricted to two languages with only
one interpreter per language, this means in detail:

* You can configure conferences with more than five conference
consoles, but only the first five conference consoles are stored.

* You can open conference configurations with more than five
conference consoles, but only the first five conference consoles are
displayed.

* During a conference, only the first five conference consoles are
displayed.

* You can only configure two interpreter booths with one interpreter
console each.

* You can open interpretation configurations with more than two
interpreter booths and more than one interpreter console per booth,
but only the first two booths with their respective first interpreter
console are displayed.

* When transmitting the interpretation configuration to the central
unit, only the first two interpreter booths with their respective first
interpreter console are taken into account.



Adjusting important basic settings

Change Password

Change Password 1
Change Password 2

Language
1. Francais
v 2.English
3. Espafiol
4. ltaliano
5. Deutsch
6. Medetlands

Adjusting important basic settings

Changing the passwords of the “Confsys” program

To change the passwords:

From the “Change Password” menu, choose “Change Password 1" to
change the password 1 or choose “Change Password 2" to change the
password 2.

The “Change Password" dialog box opens.

~& Change Password x|

Password 1

Confirm new Password + ENTER

Current Password: s+

New Password @ [sxssserns

Confirm Password; I********

Exit

In the “Current Password” box, enter the current password (see "“The
two passwords” on page 12) and press the “Enter” key.
The “New Password” box appears.

In the “New Password” box, enter the new password (eight characters
max.) and press the “Enter” key.
The “Confirm Password” box appears.

In the “Confirm Password” box, re-enter the new password and press
the “Enter” key.
The “Save” and “Cancel” buttons appear.

Click the “Save" button to save the new password; click the “Cancel”,
button to keep the current password.

Changing the menu language of the “Confsys” program

To change the menu language:

From the “Language” menu, choose the desired language.
The menu language is changed immediately.
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Configuring the conference system

This chapter provides information on how to quickly and easily configure
the consoles of your conference system (but not the consoles of the
interpretation system) using the software.

For configuring the conference system, you require the S-MM (Microphone
Management) software module which is started as follows:

Click “Start” and select “Programs”, “SDC 8200" and ““S_CM" one after
the other. Then click “Confsys”.
The “SDC 8200” window opens.

Coriguroton  Delegales  Agenda Logging St Lemguage  Change Password  Help  End

o e

13.06 2006 09:43 Disconnected Slaves2 Video's05 | CRC Errors:

The “SDC 8200" window consists of:
¢ the menu bar

Configuration Delegates Agenda Logging  Stat Language  Change Password  Help  End

If you have not licensed all of the software modules, some of the menus
will not be available in your software.

o * the “Start” button

Start for starting an already existing conference configuration
‘e ¢ the “Delegates” button
T oercontes for opening an editing the delegate database,

* the “Agenda"” button
figenda for opening and editing the agenda,
coom * the “Room Configuration” button
Configuration for opening and editing the synoptic view

¢ the status bar

| 06062006 | 1102 | Disconnected | Slaves:02 | Videos:0/5 |CRC Errors:

which shows the current date, the current time and the state of the COM
connection to the central unit (“Connected” or "“Disconnected”). In
addition, the number of slave and video PCs connected to the master PC
and the communication errors between the SDC 8200 CU central unit and
the master PC are displayed.
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Creating a synoptic view of the conference

For monitoring a conference as well as for intervening in a conference at
any time, you require a synoptic view of the conference room. In this
synoptic view, each conference console is represented by an icon.

This synoptic view can be "“wallpapered” with a background picture (e.g. a
picture of the conference room). If you then position the conference
console icons exactly where the delegates are seated, you obtain an
intuitively operable conference system.

Canfiguration From the “Configuration” menu, choose “Room” or click the “Room
Roam Configuration” button in the “SDC 8200" window.
Opfians The “Room"” window opens.
Room 1 =l
Configuration File Gid Snap
0 - | |
3:“ Conta [t
£l Microphones
71 . [o]
Mcre Mg I
AR o 8
Pty Cobes
- * —
a9 2 —
= = |
* 8 4
rs T
rg I
;.
ro T
o
10 I
5
e =
28 S
Fr -
-
Fr s
- Y
= o & on
{{ ] = ron | Com
T oS
The “Room"” window consists of:
* the menu bar,
File Grid Snap Edit Format Effect
* the “Config”, "Init” and “Vip" tabs on the right-hand side of the
window
* the canvas for displaying and editing the synoptic view
* the display of the current mouse pointer coordinates on the canvas
as well as the green “File” box for the file name (above the tabs)
[File From the “File"” menu, choose “New".
Mew The main window turns white and the “Config”, “Init” and “Vip" tabs
Open become active. “new” is displayed in the green “File” box.
Close
Sawve as
New Picture The drawing palette is not active. The drawing palette becomes active
Load Picture when you have added a background picture to the synoptic view (see
Close Picture " . . . "
T To create a new background picture for a synoptic view:” on page 24
e or "“To open an existing background picture for a synoptic view:” on

page 24).
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[File
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Open
Close

Sawve
Sawve as

MNew Ficture
Load Ficture
Close Picture

End
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You can now

* create a synoptic view (see “Positioning new conference console icons”
on page 30).

* add a background picture to an existing synopic view. We recommend
that you first add the background picture of the conference room and
then position the conference console icons.

To save a synoptic view file:

From the “File” menu, choose “Save" or choose “Save as” to save the
synoptic view under a new name or in a different folder.

To open a previously created and saved synoptic view file:

From the “File” menu, choose “Open” and select the desired * . tec file.
The selected synoptic view appears in the main window and the file
name is displayed in the green "File” box.

To close a synoptic view file without saving it:

From the “File” menu, choose “Close”.
The file is closed.
To create a new background picture for a synoptic view:

From the “File” menu, choose “New Picure”.
An empty background picture opens and you can add the drawing
objects to the picture.

To open an existing background picture for a synoptic view:

From the “File” menu, choose “Load Picture” and choose the desired
backgound picture (format: *.jpg, *.bmp, *.gif or * .fig).

The background picture opens and you can add the drawing objects to
the picture.

To close the background picture:

From the “File” menu, choose “Close Picture”.
The background picture is closed. The added conference console icons
and icon labels are retained in the synoptic view.

To add drawing objects to the background picture:

Create a new background picture
or open an existing background picture.

Use the drawing palette.
The drawing palette works like a simple drawing program.

To select an object or area:
In the drawing palette, click the “Select Area” icon.

Position the mouse pointer on the starting point of the selection
rectangle, then click and hold down the left mouse button.
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Drag the mouse pointer to the desired size of the selection rectangle
and release the mouse button.

The selected object or area can be moved with the mouse or copied
using th”copy” command.

To enlarge the background picture:

In the drawing palette, click the “Zoom" icon.

Click the picture.
The picture is enlarged.

To pick a new foreground color;

In the drawing palette, click the “Pick color” icon.

Click the mouse pointer in the desired foreground color.
The color is picked as the new foreground color.

To fill an object/area with color:

In the drawing palette, click the "Fill" icon.

Click the object/area you want to fill with the selected foreground color.
The object/area is filled with the selected foreground color.

To draw with the freeform pencil tool:

In the drawing palette, click the “Pencil” icon.

Use the mouse pointer to draw as if you were drawing with a pencil on
paper.

To erase objects or areas:

In the drawing palette, click the “Eraser” icon.
Click and hold down the left mouse button.

Move the mouse pointer over the objects or areas you want to erase.

To draw a straight line:

In the drawing palette, click the “Line” icon.

Position the mouse pointer where you want to begin to draw the line,
then click and hold down the left mouse button.

Drag the mouse pointer to the desired endpoint of the line and release
the mouse button.

To draw an arrow:

In the drawing palette, click the “Arrow” icon.
The arrow head appears where you release the mouse button.

Position the mouse pointer where you want to begin to draw an arrow,
then click and hold down the left mouse button.

Drag the mouse pointer to the desired endpoint of the arrow and
release the mouse button.

To draw a rectangle:

In the drawing palette, click the “Rectangle” icon.

Select the desired fill style.
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* Border: foreground color; interior: colorless

* Border: foreground color; interior: background color

* Border: colorless; interior: background color

Position the mouse pointer on the starting point of the rectangle, then

click and hold down the left mouse button.
To draw a square, hold down SHIFT key while drawing.

Drag the mouse pointer to the desired size of the rectangle and release
the mouse button.

To draw a rounded rectangle:

In the drawing palette, click the “Rounded Rectangle” icon.

Select the desired fill style.

* Border: foreground color; interior: colorless

* Border: foreground color; interior: background color

* Border: colorless; interior: background color

Position the mouse pointer on the starting point of the rounded

rectangle, then click and hold down the left mouse button.
To draw a rounded square, hold down SHIFT key while drawing.

Drag the mouse pointer to the desired size of the rounded rectangle
and release the mouse button.

To draw an ellipse or a circle:

In the drawing palette, click the "“Ellipse” icon.

Select the desired fill style.

* Border: foreground color; interior: colorless

* Border: foreground color; interior: background color

* Border: colorless; interior: background color

Position the mouse pointer on the starting point of the ellipse, then

click and hold down the left mouse button.
To draw a cicle, hold down SHIFT key while drawing.

Drag the mouse pointer to the desired size of the ellipse and release the
mouse button.

To draw a polygon:

In the drawing palette, click the “Polygon" icon.

Select the desired fill style.

* Border: foreground color; interior: colorless

* Border: foreground color; interior: background color

* Border: colorless; interior: background color

Position the mouse pointer on the starting point of the polygon, then
click and hold down the left mouse button.

Click the next points of the polygon and double-click to close the
polygon.

To enter text:

In the drawing palette, click the “Text" icon.

Select the desired font for the text.
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Click the desired starting point of the text.
You can only enter one line of text.

To draw a curve:

In the drawing palette, click the “Curve” icon.

Click the canvas.
A curve is drawn.

Move the starting and endpoint of the curve.

Move the little squares.
The slope of the curve is changed.

To paint with the brush:

In the drawing palette, click the “Brush” icon.

Select the desired brush stroke width.
Select the desired brush tip shape.

Position the mouse pointer on the canvas, then click and hold down the
left mouse button.

Drag the mouse pointer to paint with the brush and release the mouse
button.

To paint with the airbrush:

In the drawing palette, click the “Airbrush” icon.

Position the mouse pointer on the canvas, then click and hold down the
left mouse button.

Drag the mouse pointer to paint with the airbrush and release the
mouse button.

To select the stroke width:

In the “’Stroke width"” palette, click the desired stroke width.

The “Stroke width"” palette only appears after you have click a certain
icon (e.g. “Select Area” or “Zoom") on the drawing palette.

To assign colors:

The two uppermost color boxes on the color palette display the foreground
and the background color.

To change the foreground color:

If the foreground color box is selected, select a new foreground color
from the color palette.
The foreground color is changed.

In the color palette, double-click the foreground color box (shown in
black in the example screenshot).
The “Color” window opens.
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Basic colors:

Custom colors:

R Y
R O o

Wefine Custonn Calars >

Cancel |

Edit
Undo  Ctrl+Z
Redo  Cirl+y

Cut Crl+3

Copy  Ctl+C
Paste  Ctrl+y
Delete Del

Fill Style »  Dash

Foreground Calor... gothD
Fill Color.. DaShDDID t
Font. Ctrl+F Sttt
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In the “Color” window, click the desired color or define your own color.
The foreground color is changed.

To change the background color:

In the color palette, double-click the background color box (shown in
white in the example screenshot).
The “Color” window opens.

In the “Color” window, click the desired color or define your own color.
The background color is changed.

To undo the last drawing operation:

From the “Edit” menu, choose “Undo”
or press the key combination Ctrl + Z .
The last drawing operation is undone.

To redo the last undone drawing operation:

From the “Edit” menu, choose “Redo”
or press the key combination Ctrl + .
The last undone drawing operation is redone.

To cut a selected area:

From the “Edit” menu, choose “Cut”
or press the key combination Ctrl + X.
The selected area is cut and saved on the clipboard.

To copy the selected area to the clipboard:

From the “Edit” menu, choose “Copy”
or press the key combination Ctrl + C.
The selected area is copied to the clipboard.

To paste the cut or copied area from the clipboard onto the canvas:

From the “Edit” menu, choose “Paste”
or press the key combination Ctrl + “V".
The cut or copied area is pasted to the upper left corner of the canvas.

To delete the selected area:

From the “Edit"” menu, choose “Delete”
or press the “Del” key.
The selected area is deleted.

To set the border style for a drawing object:

From the “Format” menu, choose “Border Style".
Set the border style of a drawing object.

* Solid: solid line

e Dash: dashed line
* Dot: dotted line
e DashDot: dashdot line

¢ DashDotDot: dashdotdot line
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To set the fill style for a drawing object:

Format From the “Format” menu, choose “Fill Style".
Border Styls 3 Set the fill style of a drawing object.
Fill Style g v Salid . -
__ - . * Solid: solid fill
Horizontal Line
Foreground Calar... ) ) . I o .
E1l Color “ertical Ling * Horizontal Line: horiziontal lines
D d Di | . . -
Fant.. Cul+F STIETE ~1asana * Vertical Line: vertical lines
Upward Diagonal
Cross * Downward Diagonal: downward diagonal lines
Di Ic . : .
el « Upward Diagonal:  upward diagonal lines
* Cross: horizontal and vertical cross lines
* Diagonal Cross: diagonally crossed lines

To set a foreground color for drawing objects:

Format From the “Format” menu, choose “Foreground Color".

Border Style » The color palette opens.

Fill Style v

Faoreground Color...

Fill Calar...

Fant... Ctrl+F
Color Set the foreground color for drawing objects by clicking the desired
Basic calors: color on the color palette or define your own color.

B rErEEE To set a fill color for drawing objects:

| Wil B ol | | " " . i
From the “Format” menu, choose “Fill Color".
HTMENENNEN

EEEEEEEN The color palette opens.
L L Set the fill color for drawing objects by clicking the desired color on the
Custom colors: color palette or define your own color.

LT
I o o

Define Custom Colars >3 |

Cancel |

To select the font type for a text object:

Farmat From the “Format” menu, choose “Font”.

Border Style » A window for selecting the font type appears.
Fill Style v

Faoreground Color...
Fill Calar...
Fant... Crl+F

To resize the background picture:

From the “Effect” menu, choose “Resize”.

3 .
Y s Select the scaling type.
Fotste »  75% * Both:  the aspect ratio is kept constant
- 5%
Clecy 150; * Width: scales the width of the picture
176% * Height: scales the height of the picture
200%
v Both Select the desired scaling factor (in percent).
Width The background picture is resized and the drawing object are either
Height streched or compressed.
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To flip the background picture:

From the “Effect” menu, choose “Flip”.

Select the desired flipping axis.
* Horizontal: flips the picture horizontally, along the vertical axis

* Vertical: flips the picture vertically, along the horizontal axis

To rotate the background picture:

From the “Effect” menu, choose “Rotate”.

Select the rotating direction.
¢ Clockwise: rotates the picture clockwise

* Anti-Clockwise: rotates the picture anti-clockwise

Select the desired rotation angle.
The background picture is rotated by the selected angle.

To delete the background picture and the drawing objects:

From the “Effect” menu, choose “Clear”.
The background picture and the drawing objects are deleted.
The synoptic view remains unchanged.

To add a conference console icon:

Or:

In the “Party Color” box on the “Config” tab, click the color for the
conference console icon.

You can change this color at any time by clicking the conference console
icon and then clicking another color in the “Party Color” box.

Click one of the two “Micro +" buttons.

hicro +

Clicking the left “Micro +" button adds a small icon, clicking the right
“Micro +" button adds a large icon.

The icon appears in the upper left corner of the window. If you click one
of the two “Micro +" buttons several times in succession, the icons
appear side-by-side in the upper left corner of the window.

The conference console icons are automatically assigned a provisional
microphone number which is displayed both on the icon and in the
“N° Micro” field. The icon with the provisional microphone number “1”
is configured as the chairman unit. You can, however, configure any
other conference console as the chairman unit at any time, i.e. before
(see "Defining the console icon for the chairman unit” on page 33) or
during a conference (see “Configuring the chairman unit during a
conference” on page 73).

Drag the conference console icon, e.g.
the desired location.
The provisional microphone number is assigned.

from the “Config” tab to
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To move conference console icons to a new location:

Click the icon to be moved and hold down the left mouse button. While
you are still holding down the mouse button, move the icon to the
desired location.

To exactly align conference console icons with the grid:

In the “Grid” box on the “Config” tab, click the “On" option button or
choose “Grid on” from the “Grid” menu.
The grid is displayed.

Click the green "Grid Value"” field, enter the desired distance between
the grid lines and press the “Enter” key.
The distance between the grid lines is changed.

The distance between the grid lines should be large enough to allow a
console icon to fit comfortably between them (“Grid Value” approx.
750" to “1750").

In the “Snap” box on the “Config” tab, click the “On" option button or
choose ““Snap On” from the “Snap” menu.

Move anicon close to a grid line intersection. When releasing the mouse
button, the icon will automatically snap to the grid line intersection.

The icons are also aligned with the grid when the grid itself is hidden
but the “Snap” option is activated.

To delete a conference console icon:

Click the “Micro --" button.
The last icon added is deleted.

If you click the “Micro --" button several times in succession, the last
icons added are deleted one after the other.

To enlarge/reduce the size of a conference console icon:

Press the “Ctrl” key and keep it pressed.

Click the conference console icon (several times).
The size of the conference console icon is changed. Each click changes
the size from small via medium to large.

You can edit all conference console icons simultaneously, e.g. you can
* move them to a new location,

* enlarge/reduce their size,

* change the spacing between them or,

* flip them horizontally or vertically.

To simultaneously edit all conference console icons:

Click the empty square button at the left above the “Config” tab.
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— Cffset
# (Hor) :ID
¥ (Wert) :ID

Apply |

— Microphone Size —
= Mormal

" Big

" Extra big

Apply |

Hax (HDr):IBDDD Apply |
Y-ax Mert) :ISDDD Lpply |

Scale %:|10c|

Apply |

Cancel |

The dialog box shown on the left opens.

To move all conference console icons to a new location:

In the “X (Hor)” field, enter the number of pixels by which all
conference console icons are to be moved horizontally. Negative values
will move the icons to the left, positive values will move all icons to the
right.

In the "Y (Vert)” field, enter the number of pixels by which all
conference console icons are to be moved vertically.

Click the “Apply” button next to the “X (Hor)” and “Y (Vert)" fields.
All icons are moved by the number of pixels entered.

To change the size of all conference console icons:

In the “Microphone size"” box, click the “Normal”, “Big” or “Extra big"
option button.

Click the “Apply” button next to the “Normal”, “Big” and “Extra big”
options buttons.

The size of all icons is changed. Please note, however, that the spacing
between the icons is NOT changed.

To move all conference console icons by flipping them horizontally or
vertically:

In the “X-ax (Hor)" field, enter the position of the horizontal axis along
which the icons are to be flipped. At a value of 8200, the axis runs
horizontally through the center of the image.

Click the “Apply” button next to the “X-ax (Hor)"” field.
All'icons are flipped along the selected axis.

In the “Y-ax (Vert)” field, enter the position of the vertical axis along
which the icons are to be flipped. At a value of 8200, the axis runs
vertically through the center of the image.

Click the “Apply” button next to the “Y-ax (Vert)” field.
All'icons are flipped along the selected axis.

To change the spacing between the conference console icons:

In the “Scale %" field, enter the value for the desired distance between
the icons. Values above 100% will increase the distance, values below
100% will reduce the distance.

Click the "Apply” button next to the “Scale %" field.
The distance between the icons is changed.

To exit the dialog box without editing the conference console icons:

Click "Cancel”.
The dialog box closes.

If a certain conference console is not being used during a conference, you
can hide the corresponding icon as follows:

Click the icon to be hidden.
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In the "“Visible” box on the “Config” tab, click the “No” option button.
The icon turns orange (exception: the icon of the chairman unit is
always pink). When you start the conference, this icon is invisible.

make a hidden icon visible again:

In the “Visible” box on the “Config” tab, click the “Yes" option button.
The original color of the icon is restored. When you start the
conference, this icon is visible again.

add a short label to the conference console icon:
In the “Label” box on the “Config” tab, click the “Add Label” button .

The label appears in the upper left corner of the window. If you click the
"Add Label” button several times in succession, the labels appear one
above the other and you can only edit the uppermost label.

Or:

To

To

Drag the icon label @ from the "“Config” tab to the desired
location.

Enter the desired text.
You can enter a maximum of nine characters.

You can automatically add the icon labels (see “Labelling conference
console icons automatically” on page 46). For this, you must have a
delegate list (see “Entering delegate data” on page 51).

move and align an icon label:

Proceed as described for the console icons.

delete anicon label:

Click the "Delete Label” button.
The last icon label added is deleted.

If you click the “Delete Label” button several times in succession, the
last icon labels added are deleted one after the other.

Chairman units provide you with certain rights and privileges:

If the chairman presses the microphone key ((fé , he can take the floor
immediately without first having to make a request to speak.

If the chairman presses the priority key X% ), all active conference con-
soles — except for the VIP units — are turned off.
If the chairman presses the NEXT key »& (3, he assigns the “speaking

right” to the next participant who has made a request to speak (only in
" n OI’ " " mOdE).

To define a certain console icon as the icon for the chairman unit:

In the “Chairman” box on the “Config"” tab, click one of the rows in the
table of chairman units.
The button for opening the drop down list appears.
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P Click the drop down list and select the provisional microphone number
of the chairman unit. You can configure as many chairman units as you
want.

The console icon with the corresponding number turns pink. When you
start the conference, this conference console is configured as the
chairman unit.

You can change this configuration at any time during the conference
(see “Configuring the chairman unit during a conference” on page 73).

Note:

Make sure that only conference consoles which feature a priority
key 3% @) (SDC 8200 C, SDC 8200 CC or SDC 8200 CV) are configured as
a chairman unit!

Defining groups

The software for the SDC 8200 conference system allows you to combine
certain conference consoles in groups. There are two types of groups:

» Audio groups allow you to preselect different audio settings for different
participant groups. You can, for example, set the volume of the built-in
loudspeakers of all conference consoles assigned to a certain group
higher or lower than the volume of the built-in loudspeakers of the other
conference consoles.

* Voting groups allow you to restrict the participation in votes to certain
participant groups.

Notes!

You can define a maximum of 20 groups. One group can comprise a
minimum of one and a maximum of all conference consoles. Delegate
units, VIP units and chairman units can be arbitrarily mixed in one
group.

Each conference console can only be assigned to a single audio group
and a single voting group at a time, i.e. one conference console cannot
be assigned simultaneously to several audio groups or voting groups.

To define an audio group:
P> Press the “Ctrl” key and keep it pressed.

b Right-click the first conference console which is to be added to the
audio group.
The dialog box for editing groups opens.

P From the “Audio Group” drop down list, choose the number to be
assigned to the audio group. This number must be higher than “01""!

P In the “Description” field, enter an unambiguous description of the
audio group.

» Click the “Change” button next to the “Description” field and choose a
group color for the audio group from the color palette.

» Click “OK".
An audio group with the selected number and description is created
and the conference console is added to the newly created audio group.
In addition, a standard audio group “01" is created automatically. All
conference console which are not added to an audio group with a
number higher than “01"” are automatically added to the standard
audio group “01".
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To define a voting group:

>
>

Press the “Ctrl” key and keep it pressed.

Right-click the first conference console which is to be added to the
voting group.
The dialog box for editing groups opens.

From the “Vote Group” drop down list, choose the number to be
assigned to the voting group. This number must be higher than “01"!

In the “Description” field, enter an unambiguous description of the
voting group.

Click the “Change” button next to the “Description” field and choose a
group color for the voting group from the color palette.

Click "OK".

A voting group with the selected number and description is created and
the conference console is added to the newly created voting group.

In addition, a standard voting group “01" is created automatically. All
conference console which are not added to a voting group with a
number higher than “01"” are automatically added to the standard
voting group “01".

Adding a conference console to a group

To add a conference console to an existing group:

Press the “Ctrl” key and keep it pressed.

Right-click the conference console which is to be added to a group.
The dialog box for editing groups opens.

From the “Audio Group” drop down list, choose the number of the
audio group to which the conference console is to be added and/or
from the “Vote Group” drop down list, choose the number of the voting
group to which the conference console is to be added.

The description of the selected group and the group color are displayed.
(You can edit the description and the group color as described under
""Defining groups” on page 34.)

Click “OK".
The conference console is added to the group.

Removing a conference console from a group

To remove a conference console from an exisitng group:

>
>

Press the “Ctrl” key and keep it pressed.

Right-click the conference console which is to be removed from a group.
The dialog box for editing groups opens. The number, the description
and the group color of the assigned audio group and voting group are
displayed. (You can edit the description and the group color as
described under “Defining groups” on page 34.)

To remove a conference console from an audio group, choose the
number “01"” from the "Audio Group” drop down list; to remove a
conference console from a voting group, choose the “01"” from the
"Vote Group” drop down list.

Click "OK".
The conference console is removed from the group.
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Displaying the overview of groups

To display to assignment of a conference console to an audio group or a
voting group:

» On the “Config” tab, click the “Group” button.
The “Group Overview" dialog box opens.

P From one of the two drop down lists “Audio Group” or “Vote Group”,
choose the number of the group to be displayed.
The description of the selected group and the group color are displayed.
(You cannot edit the description and the group color in this dialog box.)
In addition, the provisional microphone numbers of all conference
consoles assigned to the selected group are displayed in the
“Members"” list.

» Click the “Show" button.
Inthe “"Room"” window, all conference consoles assigned to the selected
group are highlighted in the group color of the group.

To return to the normal display:

P In the “Group Overview" dialog box, click the “Close” button.
All conference consoles are displayed in their original color instead of
the group color.

Configuring VIP units

VIP units are delegate units with special “rights” and privileges:

e With a VIP unit, you can take the floor at any time by pressing the
microphone key (((Zé (®, regardless of the conference mode and without
first having to be assigned the “speaking right”.

* If the chairman presses the priority key 3% @@, all active conference
consoles — except for the VIP units — are turned off. The chairman cannot
withdraw the “speaking right” from you.

To assign the VIP status to a conference console:

P Make sure that the “VIP enabled” check box on the “Vip” tab shows a
tick.

P On the "Vip" tab, click one of the rows in the table of VIP units.
The button for opening the drop down list appears.

p Click the drop down list and select the provisional microphone number
of the VIP unit. You can configureup to ten VIP units.

During a conference, VIP units are marked with a blue square in the upper
left corner of the conference console icon. During a conference, these blue
squares can be displayed or hidden by clicking the “VIP: ON" button in the
tool palette.

[7]

To withdraw the VIP status from a conference console:

P On the "“Vip"” tab, click the row with the VIP unit to be removed in the
table of VIP units.
The button for opening the drop down list appears.

P Press the DELETE key.
The VIP unit is removed from the table.
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Initializing the conference consoles

After you have created a synoptic view of the conference, you have to

assign a real conference console to each console icon of the synoptic view.

To do so, you have to either automatically or manually initialize the

conference consoles:

* When performing an automatic initialization, the microphone numbers
are assigned in an arbitrary order.

* When performing a manual initialization, the microphone numbers are
assigned in a certain order. If your synoptic view comprises icon labels
showing the names of the delegates, you should perform a manual
initalization.

Before starting the initialization:
Make sure that

e anicon is created for each conference console,
* all conference consoles are connected correctly and
¢ the central unit is turned on.

To initialize the conference consoles:

Click the “Init” tab.
The “Init"” tab appears in front of the “Room” window.

To automatically initialize the conference consoles:

On the “Init” tab, click the “Automatic Init” button. In the “Start
Initialisation?” dialog box that opens, click “Yes".

All conference consoles are initialized automatically. The icons of
correctly initialized conference consoles are displayed in green in the
synoptic view. Please note that “invisible” conference console icons are
also assigned a microphone number.

All consoles with a display panel display the microphone number which
does correspond to the provisional microphone number displayed
on the conference console icon!

When all icons in the synoptic view are displayed in green and “0"
appears behind “Unknown” in the green Info box, click the “End Init"
button.

Save this configuration by choosing “Save” from the “File” menu.
Your conference system is now ready for operation.
To manually initialize the conference consoles:

On the “Init” tab, click the “Full Init” button. In the “Start
Initialisation?” dialog box that opens, click “Yes".

The signal lights rings of all connected conference consoles start
flashing.
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One after the other, press the microphone key («ZE on all conference
consoles in which the conference console icons in
the synoptic view are numbered!

The signal light ring goes off and the conference console icon is
displayed in green. The conference consoles are assigned sequential
microphone numbers in exactly the order in which you press the
microphone key («ZE

When all icons in the synoptic view are displayed in green and “0"
appears behind “Unknown" in the green Info box, click the “End Init"”
button.

Save this configuration by choosing “Save” from the “File” menu.
Your conference system is now ready for operation.

If some conference consoles were not initialized in the desired order, the
synoptic view does not agree with the real configuration. However, you
can assign a certain conference console a new microphone number by first
deleting the current microphone number and then assigning a new one.

To delete an assigned microphone number:

On the “Init” tab, click the “Open Init” button. In the *Start
Initialisation?” dialog box that opens, click “Yes".

In the “Delete — Reserve” box, click the “Delete” option button.

Click the “0000" field and enter the four-digit microphone number you
want to delete.

Click the "Delete — Reserve" button.

The conference console icon with the previously entered microphone
number turns light-blue and the signal light ring of the corresponding
conference console starts flashing.

You can assign this conference console a new microphone number by
pressing the microphone key («ZE

Click the “End Init” button.

The conference console with the previously entered microphone
number is deinitialized. If this consoles has a display panel, the text
“Init refused” is displayed. You then cannot use this conference console
during the conference.

To assign a different microphone number:

On the “Init” tab, click the “Open Init” button. In the *Start
Initialisation?” dialog box that opens, click “Yes".

In the “Delete — Reserve” box, click the “Reserve” option button.

Click the “0000" field and enter the four-digit microphone number you
want to assign.
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Click the "Delete — Reserve” button.

Delete - Reserve The conference console icon with the previously entered microphone

number turns magenta.

Click the “End Init” button.
End Init The previously entered microphone number is deleted.

On the “Init” tab, click the “Open Init” button. In the “Start

Open Init Initialisation?” dialog box that opens, click “Yes".
The signal light ring of the corresponding conference console starts
flashing.

You can now assign this conference console a new microphone number
by pressing the microphone key ((fé

Click the “End Init” button.
End Init The new microphone number of the conference console is saved.

On the “Init"” tab, click the “Get Init Info".
Get init info The status of each conference console icon is displayed:

* Green conference console icon:
The conference console is initialized correctly.

Light-blue conference console icon:
The conference console’s microphone number is deleted.

* Magenta conference console icon:
The conference console’s microphone number is reserved.

* Gray conference console icon:
The conference console is not initialized correctly.

* White conference console icon:
The conference console is initialized correctly and a chip card is
inserted.
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Selecting the conference options

Many features which determine the character of your conference, e.g. the
conference mode, the speaker limit or the maximum speaking time, are
configured in the “Options” menu.

To get into the “Options” menu:
Close the “Room” window by clicking “End” on the menu bar.
From the “Configuration” menu, choose “Options”.

The “Options” window opens. This window contains the “Confsys" tab,
the “CU"” tab and the “Maintenance” tab.
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* Automatic saving of the configuration when exiting the program (see
"Configuring the saving options” on page 42)

Voting options as well as file paths and names of the logos in the voting
window (see “Configuring the menu language of the software” on
page 44)

Protocol functions (see “Configuring the log files” on page 47)
* Text that is automatically added to the log databases as a heading

* Menu language of the software (see “Configuring the menu language of
the software” on page 44)

* Automatic labelling of the conference conole icons in the synoptic view
(see "Labelling conference console icons automatically” on page 46)
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Automatic limiting of the speaking time (see “Configuring the speaker
limit” on page 49)

* Configuration of the network PCs as master, slave or video PC (see
"Configuring the PCin a network” on page 44)

* Autostart configuration and file paths of the synopic view and the
delegate database (see “Configuring the startup options” on page 43)

* File paths of the log and safety files (see “Configuring the log files” on
page 47)

* File paths of the sound files (see “Configuring acoustic signals” on
page 45)
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* Configuration of the conference mode (see "“Configuring the conference
mode” on page 48)

* Max. number of simultaneously active consoles (see “Configuring the
speaker limit” on page 49)

e Connection to the central unit (on or off)

* Configuration and test of the connection between the central unit and
the PC (see “Configuring the COM port” on page 49)
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* Deletion of the log databases (see "“Deleting log databases” on page 48)

To set the program behaviour on exit:

In the “Autosave” box on the “Confsys” tab, click the desired option
button.

* If you click the “Off” option button, a dialog box asks you to save your
changes before you exit the program. You can either save or not save
the changes.

e If you click the “On"” option button, your changes are saved
automatically when you exit the program.

To preset the voting mode:

In the “Vote mode — 1 of...” box on the “Confsys" tab, click the desired
option button.

* If you click the 3" option button, voting automatically starts in “1 of
3" mode.

* If you click the 5" option button, voting automatically starts in "1 of
5" mode (only if the SDC 8200 SYS software is being used).

You can change the selected voting mode at any time (see "“Selecting
the voting mode” on page 85).

To allow/prevent changing the vote cast:

In the “Vote Correction” box on the "Confsys” tab, click the desired
option button.
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* If you click the “OFF"” option button, a delegate cannot change the
vote cast.

* If you click the “ON" option button, a delegate can change the vote
cast until the voting time is over.

To configure the printouts of voting results:

Presence In the “Presences” box on the “Confsys” tab, click the desired option
Q e button.
= Micros

* If you click the “Name” option button:
In the printout, the voting results are assigned to the names in the
delegate database. For this the S-DM software module is required.

* If you click the “Micros” option button:
In the printout, the voting results are assigned to the microphone
numbers.

To add a heading to the printouts and log files of the voting results, the
delegate list and the agenda:

In the “Votetext” box on the “Confsys” tab, click the desired option

"\futetext

button.

We recommend entering the title of your conference. Via this title, it
will later be possible to clearly assign all printouts to a certain
conference.

To add up to two logos to the voting window:

In the “Logol” or “Logo2” box on the "“Confsys” tab, specify the file

rLogol

path and the * . bmp file of the logos.

The logos then appear one above the another on the top right of the

rLogoZ

L] voting window (see “Loading the agenda file” on page 82).

To set the program behaviour on startup:

In the “Autostart” box on the "Confsys” tab, click the desired option
button and specify the desired files under “Room file” and “Delegate

file".
Autostart — - Autostart
Room file
i OFF I J
Lol Diatei Teilnehmerdatenbank

| o

* If you click the “OFF" option button, no configuration is loaded when
the program is started and the empty “SDC 8200"” window appears.
This setting is recommended for conference systems with a
frequently changing configuration and changing delegates.

* If you click the “ON"” option button, the synoptic view of the
conference room preset under “Room file” and the delegate data
selected under “Delegate file” are loaded automatically.

This setting is recommended for conference systems with an
unchanging configuration.
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To display the menus and buttons of the software in a different language
immediately after program startup:

In the “Language” box on the “Confsys” tab, click the desired option
button.

You can change the menu language at any time (see “Changing the
menu language of the “Confsys” program” on page 21).

If you have installed the software in parallel on several PCs, it is necessary
to specify the tasks of the PCs in the network:

* Master:
Control of the conference system and/or control of the interpretation
system, access control (dongle)

* Slave:
Control of the conference system and/or control of the interpretation
system

* Video:
Display of the synoptic view of the conference room, the delegate names
and the voting results (e.g. via a projector)

Your network administrator will give you the required TCP/IP addresses
of your PCs.

If the PCis to be configured as the master PC:

In the “Program” box on the “Confsys” tab, click the “Master” option
button.

Enter the TCP/IP addresses of the corresponding PCs in the “Master”,
“Slavel” and “Video” boxes of the “TCP/IP address" box.
This PC is now configured as the master PC.
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If the PCis to be configured as a slave PC:

In the “Program” box on the “Confsys” tab, click the “Slave” option
button.

Enter the TCP/IP address of the master PC in the “Master” box of the
“TCP/IP address” box.

Enter the TCP/IP address of the first slave PCin the ““Slavel” box of the
“TCP/IP address” box.
This PC is now configured as a slave PC.

If the PCis to be configured as a video PC:

In the “Program” box on the “Confsys” tab, click the “Video” option
button.

Enter the TCP/IP address of the master PC in the “Master” box of the
“TCP/IP address” box.

Enter the TCP/IP address of the video PC in the “Video” box of the “TCP/
IP address” box.
This PC is now configured as a video PC.

To prevent the video PC, at which no-one is working because it is used for
display purposes only, from starting the screensaver:

Make sure that the screensaver of the video PC is deactivated.

You can couple different system events with an acoustic signal. The
acoustic signal is output via the sound card of the master PC (not via the
conference consoles’ built-in loudspeakers).

In the “Sound” box on the “Confsys” tab, click the “On" option button.

Specify * . wav files for the different system events.
* If you enter a * . wav file in the “Micro On” box, it will be played each
time a microphone is activated.

* If you enter a * . wav file in the “Micro Off” box, it will be played each
time a microphone is deactivated.

* If you enter a * .wav file in the “Micro Request” box, it will be played
each time a delegate makes a request to speak.
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* If you enter a * . wav file in the “Bell” box, it will be played each time
you click the “Bell” button (see “Triggering acoustic signals” on
page 81).

e If youenter a * . wav file in the “Start” box, it will be played each time
you click the “Start” button (if you enter a * . wav file in the “Speech
Timer" box, it will be played each time the preset max. speaking time
is reached (see “Using the “Global” option button in the “Speech
Timer” box" on page 69).

Some suitable *.wav files can be found in the folder
“C:\Programs\SDC8200\S_CM".

To configure the automatic labelling of the conference console icons:

In the “Automatic Label” box on the “Confsys” tab, click the desired
option button.

* If you click the “None" option button, no icon label is automatically
added to the conference console icon.

* If you click the “Delegate database” option button, an icon label with
the name of the delegate is automatically added to the conference
console icon.

* If you click the “Badge name” option button, an icon label with the
name read from the chip card is automatically added to the
conference console icon (only if the SDC 8200 SYS software is being
used). If no chip card is inserted, no name will be displayed.

* If you click the “Mix" option button, an icon label with the name read
from the chip card is automatically added to the conference console
icon. If no chip card is inserted, the name from the delegate database
will be displayed.

Choose the position where the icon label is to be added:

e above: theicon label is added above the console icon

* below: theicon label is added below the console icon

* right:  theicon label is added at the right of the console icon

* left: the icon label is added at the left of the console icon

To configure the maximum speaking time:

In the “Speech Timer” box on the “Confsys” tab, click the desired option
button.

Speech Timer

 Off Default “alue (min)l 1
* Global
" Single Delegate Time before blink (sec)l 15

* If you click the “Off” option button, all delegates can speak for an
unlimited time.

* If you click the “Global” option button, you can start the speaking
time countdown at any time (see “The displays on the control
palette” on page 67). After the maximum speaking time has been
reached, all microphones are deactivated automatically.
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* If you click the “Single Delegate” option button, an individual
speaking time countdown is started for each speaker. After the
maximum speaking time has been reached, the speaker’s micro-
phone is deactivated automatically. You can interrupt or cancel the
countdown at any time (see “Using the “Global” option button in the
"Speech Timer” box” on page 69). The red signal light ring starts
flashing before the maximum speaking time is reached. The “Global”
option can be used in parallel.

In the “Default Value (min)” field, enter the maximum speaking time in
minutes.
The maximum speaking time can be set from 1 to 200 minutes.

In the “Time before blink (sec)” field, enter the duration of the flashing
of the red signal light ring in seconds.

A flashing red signal light ring indicates that the speaking time will
soon be over.

To configure the log files for different system events:

* “Microphone Logging"”
Whenever a console is activated/deactivated, the microphone number,
the data of the delegate and the date and time are saved in a log file.

* “Badge logging”
Whenever a chip card is inserted into or removed from the chip card slot
of a console, this is saved in a log file.

* “Vote Logging”
All voting items are saved in individual log files.

* “Chronological Logging”
All system events are saved in a log file:

* Start/end of a conference + name of the conference,

* Activation/deactivation of a microphone + name of the delegate,
* Insertion/removal of a chip card + name of the delegate,

* Opening/closing the agenda + name of the delegate,

e Starting time/ending time of a voting item + description.

All log files of a conference are managed by a database. After the
conference, these databases are automatically saved in a folder to be
specified in the “Path data” box (see “Selecting the folders for saving the
voting results, safety copies and log files” on page 48). The format of the
name of a database is as follows:

LOG_year_month_day_hourminutesseconds.mdb
LOG_2006_10_03_123031.mdb
After the conference, the log files can be printed or saved as described
under “Viewing, exporting and printing log files” on page 64).
To configure the log files:

In one of the boxes "Microphone Logging”, “Badge Logging”, “Vote
Logging” and “Chronological Logging” on the “Confsys” tab, click the
desired option button.

* If you click the "“On” option button, the desired log file is
automatically created after the conference. The log file is saved in the
database.
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To select the folder for saving the different system files:

In the boxes “Path voting”, “Path copy” and “Path data” on the
“Confsys" tab, select the folders in which the files are to be saved.

* Files with voting results are saved in a folder to be specified in the
“Path voting” box.

* All files are additionally saved in a folder to be specified in the “Path
copy” box.

* Log databases are saved in a folder to be specified in the “Path data”
box.

If you use several PCs (video, slave), it is absolutely necessary to ensure

¢ that the same folder is set on the same network drive of all PCs,

* that this folder is shared so that other PCs can access it (refer to the
Windows Help for full details on sharing folders) and

e that the PC with this network drive is turned on during the
conference!

We therefore urgently recommend selecting a folder on the master PC
for saving the log databases!

You can manually delete the log databases or set a deadline after which
the log databases are automatically deleted:

In the “Cleanup log file” box on the “Maintenance” tab, click the “On”
option button.

In the white field, enter the deadline (in days) after which the log
databases are to be automatically deleted.

In the “Ask confirmation” box, choose whether or not the log databases
are to be deleted without asking for confirmation.

 Off: the log databases are deleted without asking for confirmation.
* On: the log databases are only deleted after your confirmation.

To preset a conference mode:

In the “Mode” box on the “CU" tab, click the desired option button.

e For information on the ten different conference modes, see
"Operating the delegate units” on page 28 of the SDC 8200 system
manual.

* You can also change the conference mode at any time during a
conference (see “Changing the conference mode during a
conference” on page 79) — however, this causes all consoles to turn
off automatically.
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To limit the number of simultaneously active consoles:

In the “Max Micro ON"” box on the “CU" tab, click the desired option
button.

This only concerns the conference modes “Request”, "Direct Access”
and “Override”. In all other conference modes, the speaker limit is auto-
matically set to the corresponding value.

To activate or deactivate communication with the central unit:

In the “Connection to CU” box on the “CU" tab, click the desired option
button.

* If you click the “On” option button, the software tries to
communicate with the SDC 8200 CU central unit on startup. The “On”

option button be active for the PC control of the conference
system to function correctly!
* If you click the “Off” option button, you control your

conference system via the software!

If you wish to create a configuration even though no consoles are
connected, the "Off"” option allows you to avoid the constant display
of the “No communication” dialog box.

To configure the COM port of the PC for communication with the central
unit:

Connect the central unit to the RS 232 interface of your PC as described
under “Connecting the PC to the central unit” on page 15.

Turn on the central unit.

Make sure that the “On” option button in the “Connection to CU"” box
on the “CU" tab is clicked.

In the “COM port PC" box on the “CU" tab, click the correct COM port.
This COM port must correspond to the serial RS 232 interface of the PC
to which the SDC 8200 central unit is connected.

If you click a COM port which is not available on your PC, a dialog box
with the message “COMx not available” appears (“x" corresponds to
the COM port number).

If you do not know the correct COM port, try the different options one after
the other:

In the “COM port PC"” box, first click a COM port and then click the “Test"”
button.
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Save and Exit |

Cancel and Exit |

If a dialog box with the message ““Test is successful on COMx" appears,
the PC can communicate with the central unit via the selected COM port.
Your conference system is now ready for operation.

If a dialog box with the message “Test failed on COMx" appears, you
have to try a different COM port.

Most desktop PCs have only one COM port (“COM1") or two (“COM1”
and “COM2"). Only very rarely do PCs have more than two COM ports.
The COM ports of your PC are listed under “Ports (COM & LPT)" in the
Windows Device Manager.

However, in contrast to standard desktop PCs, on a number of laptops
the infrared interface (IrDa) and not the serial RS 232 interface is
preconfigured as “COM1"”. In such a PC, the serial RS 232 interface
corresponds to “COM2".

Restart the program.

Saving the conference options

To save the selected options:

Click the “Save and Exit" button.
The “Options” window closes and all selected options become active
when the program is restarted.

To reject the selected options and keep the previous options:

Click the "“Cancel and Exit"” button.
The “Options” window closes and all previous options are kept.
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Managing delegate data

This chapter provides information on how to enter and use delegate data.

Entering delegate data

You can manually enter delegate data or import data from a file.

If you initialize the conference consoles after you created a delegate
database, the microphone numbers are fixedly assigned to the
delegate names. Therefore, the delegates always have to use the same
conference consoles in order to ensure that the correct name is
displayed in the list on the left-hand side of the “Delegates” window!

If you use chip cards, the microphone numbers are not fixedly assigned
to the delegate names. In this case, you do not have to enter any
delegate data. Instead, the delegate names stored on the chip cards are
automatically displayed in the delegate list (only if the SDC 8200 SYS

software is being used).

To create a delegate database:

From the “Delegates” menu, choose “Administration” or click the

"Delegates” button in the “SDC 8200" window.

The “Delegates” window opens.

mice: [ | [«p]
Delegats IO - :l Em
Badgen: [ |

Mame -

First Mame -

Straat :

Fostoode

Dlsmct:|

Dawotern: [ |[4]b]

Party - |

Remarks :

Voting right :| ¢

Wnite
Wvrite All I

<

Read [ ]
Read All I

The buttons for chip card management at the bottom part of the
"Delegates” window are not available in the SDC 8200 SYS-M software.

To create a new delegate database:

From the “File” menu, choose “New".

A new empty input mask is created.
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To open an existing delegate database:

P From the “File” menu, choose “Open”.
The file selection box opens.

b Specify the folder and name of the delegate list to be opened and click
the “OK" button.
All delgate names entered up to now are displayed in the list on the
left-hand side of the window. The buttons on the right-hand side of the
window become active.

wero [ (4]
S —C
KIS

Eadge MNr

Mame :

First Name : |
Stroat: |
Pastcode |

District : |

oawotein: [ |[4[M]

Party: |

Remarks :

Voting right

Wiite | S Read |
Raad Al |

Writa All |

The delgate names in the list are sorted by microphones numbers. The
middle part of the window contains the input mask and the buttons on
the right-hand side are for editing the data records.

Adding new delegate data

To add new delegate data to the dalegate database:

P In the “Delegates” window, click the “Add" button.
The insertion point appears in the “Micro” field.

P Enter the data into the different fields one after the other. Please note:
The microphone number (“Micro” box) and the name (“Name” box)
must be entered.

P Click the “Save” button.
The new data are added to the delegate database and the microphone
number, the last name and the first name of the delegate are displayed
in the list.

Changing delegate data

To change delegate data:

P In the list of the “Delegates” window, click the name of the delegate
whose data you want to change.
The data are displayed in the input mask.

» Click the “Change” button.
» Change the data.
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Delete |

Search |

<D

Move |

Click the “Save" button.
The changed data record replaces the previous record in the database.

To delete data from the delegate database:

In list of the “Delegates” window, click the name of the delegate whose
data you want to delete.
The data are displayed in the input mask.

Click the “Delete” button.
The "Delete Record” dialog box opens.

In the dialog box, click the “OK" button.
The data record is deleted from the database.

To search for specific data in the delegate database:

In the “Delegates” window, click the “Search” button.
The “Micro”, “Delegate ID”, “Name”, “District”, “Birthdate” and “Party"”
boxes turn red.

Click a red box, enter the search term and press the “Enter” key.

If the entered search term is found, the corresponding delegate name
is highlighted in the delegate list and the data are displayed in the
input mask.

To scroll through the delegate database:

In the “Delegates” window, click one of the arrow buttons.

The previous or the next entry of the corresponding box is displayed in
the input mask and the corresponding delegate name is highlighted in
the list.

If the arrow buttons are not active, click any button on the right-hand
side of the window and then interrupt the starting process by clicking
the “Cancel” button.

To move delegate data to a new microphone number:

In delegate list of the “Delegates” window, click the name of the
delegate whose data you want to move.
The data are displayed in the input mask.

Click the “"Move"” button.
A green field appears next to the “Micro” box.

Enter the desired microphone number — which must not yet be
assigned! — into the green field and press the “Enter” key.

The data of the selected delegate is moved to the new microphone
number. The entry in the delegate list is moved correspondingly.

53



Managing delegate data

Importing delegate data

Instead of manually entering delegate data, you can import them from a
text file. The text file must have the extension . txt. All delegate records
must be separated by carriage returns and all fields within each record
must be separated by semicolons.

The order of the data in the text file:

* Microphone number (Micro) 4
*ID (ID) 13
* Chip card number  (Badge Number) 4
* Last name (Name) 40
* First name (First name) 20
e Street: (Street) 30
* ZIP code (ZIP code) 4
* City (City) 20
* Organization (Party) 15
* District (District) 30

Example: “Delegates. txt”

0001; Luthi; Maria; Ramistr.10; 8092; Zirich; CH; Switzerland
0002; Becker; Martin; Goethestr.12; 1026; Vienna; A; Austria
0003; Richter; Andreas;Hofplatz 7; 1001; Vaduz; FL; Liechtenstein

To import delegate data:

Delegates
Impart Delegates From the “Delegates” menu, choose “Import Delegates”.
Adrinistration The “Import Delegates” window opens.
Print sorted by Microphone
Print sortad! by Name X
Frint sarted by Farty End

Import file name:

|C \ProgrammerSDC800MS_ChWiDataldelegates td | Selectimport file |

Destination file name:

|delegates | del Select destination file |

Start import | Clear

10;8096;Zirich;CH; Schuein
eeeeee trasse 112;10Z6;Berlin;D;Deutschland
0003 ; Archer ;Jonathan; 102, Columbia Road;0105;Leicester;UK;Great Britain

Click the “Select import file” button, select a *. txt file and confirm
your selection by clicking the “OK"” button.
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The path and the file name are displayed in the field below “Import file
name”.

Click the “Select destination file” button, specify the folder and name
of the new delegate database to be created and confirm your selection
by clicking the “OK" button.

The path and the file name are displayed in the field below “Destination
file name”.

Click the “Start import” button.

The delegate data are displayed in the lower part of the window and
the “Clear” button appears. A delegate database containing the
delegate records of the text file is automatically created and saved.

To import more delegate data:

Click the “Clear” button.
The fields are cleared and additional delegate data can be imported.

Printing a delegate list

You can print lists containing the microphone number, last name, first
name and organization of each delegate. These lists can be sorted by
microphone number, last name or by organization.

To print a delegate list:

From the “Delegates” menu, choose either “Print sorted by
microphone”, "Print sorted by name” or “Print sorted by party”.
The file selection box opens.

Select the delegate list to be printed and confirm your selection by
clicking the “OK" button.
The "“Start Printing?” dialog box opens.

Click the “OK" button.
The selected delegate list is printed.

To automatically add a heading to the printout, see “Configuring the
voting settings” on page 42.

Using chip cards

Chip cards allow you to give your conference a more personal and flexible
touch while making it more convenient. And it makes voting safer. In order
to be able to use the functionality of the chip cards, you require the
SDC 8200 SYS software:

* You do not need to enter any data into the delegate list. Instead, the

delegate list is updated automatically with the names stored on the chip
card as soon as a delegate inserts his chip card into the chip card slot of
his console.
The delegates can thus sit down at any desired console or swap places
with someone else whenever they want and the correct name is still
displayed next to the current microphone number. Absent delegates do
not appear on the delegate list.
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If you have entered names into the delegate list nevertheless, these are
overwritten by the names on the chip cards as soon as a chip card is
inserted into the chip card slot of a console. If the chip card is removed
again, a name is no longer assigned to this console

* If a delegate inserts his chip card into the chip card slot of any desired
console, his last name appears on the display of the console instead of
the microphone number.

* You can ensure that only authorized delegates participate in voting
sessions (see “Taking votes with or without chip cards” on page 84).

* You can - e.g. as a presence check — record which delegates have
inserted their chip card into the chip card slot of their console (see
""Saving or printing the data of all inserted chip cards” on page 79).

* You can use printed chip cards (e.g. bearing the logo of your conference
or conference center) and thus give your conference a personal,
individual touch.

For this, you require the S-MM, S-DM and S-VM software modules as well
as consoles with a chip card slot (SDC 8200 CV or SDC 8200 DV).

In order to write personal data of the delegates to chip cards, you require
the SDC 8200 SYS software.

From the “Delegates” menu, choose “Administration” or click the
"Delegates” button in the “SDC 8200" window.

The “Delegates” window opens.

vicro: [ | [«
sesee [ (4]
Baggenr:[ | d»

Mame : | EE

First Name : |
Stroet: ]
Posicode | Gty - | |
District :

paeotemn: [ |[4[p]

Party:

:

.

Remarks :

Voting right

)

Write All

Wiite | Q Read |
| Road Al |

The buttons for chip card management at the bottom part of the
"Delegates” window are not available in the SDC 8200 SYS-M software

Open the synoptic view.

Insert a chip card into the slot of each of the consoles. The chip must
point downwards and to the left.

The green LED on the chip card icon of the corresponding consoles
lights up. The consoles with a chip card inserted into their chip card slot
are displayed in white in the synoptic view.

Make sure that all consoles with inserted chip cards are displayed in
white in the synoptic view.
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Close the synoptic view.
Open a delegate list.
Click the “Write all” button.

Wirite | a Read | |
Read Al |

Write Al |

The delegate data from the delegate list are written the the chip cards.

This takes several seconds. The delegate’s last name then appears on

the display of the console — provided that the console has a display.
To write data to a single chip card:

Open a delegate list.

Select the desired delegate.

Insert a chip card into the slot of the delegate’s conference console.

Click the “Write” button.
The data of the selected delegate are writen to the chip card.

To read the personal data of the delegates on the chip cards, you require
the SDC 8200 SYS software.

Insert a chip card into the chip card slot of each conference console. The
chip must point downwards and to the left.

The green LED on the chip card icon of the conference consoles lights up
and the consoles are displayed in white in the synoptic view.

Click the “Read All"” button.
The data on all chip cards are read.

To read the personal data of a delegate on a single chip card, you require
the SDC 8200 SYS software.

In the field next to the “Read” button, enter the four-digit microphone
number of the conference console whose inserted chip card you want
to read.

Schreiben | Lesen | |
| 2 |

Alle schreiben Alle lesen

The data on the chip card are read into the delegate database.
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Planning and managing votes (Agenda)

In order to be able to quickly and easily take votes during a conference, you
should create an agenda including all items to be voted on.

Entering voting data

Creating or opening an agenda file

> From the “Agenda” menu, choose “Administration” or click the
“Agenda” button in the “SDC 8200" window.

» The “Agenda Items” window opens.

Amendment I:l “

Description m
mae [ ][ [ ]

Quorum Ijl% Majority El %

Copy

The upper part of the window contains the input mask, the lower part
displays the agenda and the buttons on the right-hand side of the
window are for editing the agenda.

To create an agenda file:

P From the “File” menu, choose “New".
A new empty input mask is created.

To open an existing agenda file:

P From the "“File” menu, choose “Open”.
The file selection box opens.

b Specify the folder and name of the agenda file to be opened and click
the “OK" button.
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Add

Change |

All voting items entered up to now are displayed in the agenda. The
buttons on the right-hand side of the window become active.

. C:\Programme\5DC8000\5_CM\Data\agenda. dia x|

File End
o o ] (D]
Amendment

Description : |Election of Chairperson

Index
001 00 Election of Chairperson s1 s2 s3

a

002 00 Election of Vice-Chairperson sl s2 s3
003 01 Finances, amendement 1 sl s2 s3
003 02 Finances, amendement 2 sl s2 s3
003 03 Finances, amendement 3 sl s2 s3
004 00 Salaries s1 s2 s3

m
=
a

Adding new voting items to the agenda file

To add a voting item to the agenda file:

>

>
>

In the “Agenda Items" window, click the “Add" button.
The insertion point appears in the “Item” field.

Enter the data into the different fields one after the other.

Click the “Save” button.
The new voting item is added to the agenda file and is displayed in the
agenda.

Changing voting items in the agenda file

To change a voting item in the agenda file:

>

In the agenda of the “Agenda Items” window, click the voting item you
want to change.
The data are displayed in the input mask.

Click the “Change” button.
Change the data.

Click the “Save” button.
The changed voting item replaces the previous one in the agenda file.

Changing the quorum in the agenda file

"Quorum” is the minimum number (in percent) of delegates necessary to
be present for a vote.

To change the quorum for a single voting item:

>

In the “Agenda Items” window, click the voting item which is to be
assigned a different quorum.
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Quorum : % Applyl

Quaorum : % SET |

hajority : % Apply |
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In the “Quorum” field, enter the desired percent value.

Click the “OK" button.
The changed quorum is saved in the database as soon as you save the
database file or close the “Agenda Items"” window.

To change the quorum for several voting items at the same time:

In the “Agenda Items"” window, use Ctrl-click or Shift-click to select all
voting items which are to be assigned a different quorum.

Click the "SET"” button next to the “Quorum” field.
The “Quorum Setup” window opens.

S OwnmSewp

Available Vote ltems | Selected Yote ltems |
oo 0001 G = 050%
3 | 0002 0000 ¢ = 030%
b |
g |
L8 |
3 172 of entiled to vate
> 2/3 of enliled to vote
3 344 of erliled to vote
' Custom defined
i+ Default [quonm not specified)
Reszet | Apply | Ok | Cancel |

The selected voting items are listed in the “Selected Vote Items” field.
You can click individual voting items and move them from one field to
the other by using the “arrow” buttons.

Click the option button next to the desired quorum.
If you click “Custom defined”, a box opens where you can enter any
number from 0 to 100.

Click the "Apply” button.

The selected quorum is assigned to all voting items listed in the
"“Selected Vote Items” field. All voting items are moved back the the
“Available Vote Items” field.

Click the "OK" button.

"Majority” is the minimum number (in percent) of delegates necessary to
vote in favour of a voting item in order for that voting item to be passed.

To change the majority ratio for a single voting item:

In the “Agenda Items” window, click the voting item which is to be
assigned a different majority ratio.

In the “Majority” field, enter the desired percent value.
Click the “OK" button.

The changed quorum is saved in the database as soon as you save the
database file or close the “Agenda Items" window.
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hajority : %  SET |

Delete |

Search |

To change the majority ratio for several voting items at the same time:

In the “Agenda Items” window, use Ctrl-click or Shift-click to select all
voting items which are to be assigned a different majority ratio.

Click the “SET" button next to the “Majority"” field.
The “Majority Setup” window opens.

Available Vaote ltemns | Selected Vote lterns |

0001 0001 b = 0:50%
. I 0002 0000 M = 050%

.._>>|

|

3 142 of votes

5 243 of votes

3 304 of votes

" Custom defined

¢ Default [majarity not specified)

Reset | Apply |

The selected voting items are listed in the “Selected Vote Items” field.
You can click individual voting items and move them from one field to
the other by using the “arrow” buttons.

OK | Cancel |

Click the option button next to the desired majority ratio.
If you click “Custom defined”, a box opens where you can enter any
number from 0 to 100.

Click the "Apply” button.

The selected majority ratio is assigned to all voting items listed in the
"Selected Vote Items” field. All voting items are moved back the the
“Available Vote Items"” field.

Click the "OK" button.

To delete a voting item from the agenda file:

In the agenda of the “Agenda Items” window, click the name of the
voting item you want to delete.
The data are displayed in the input mask.

Click the "Delete” button.
The “Delete Record?"” dialog box opens.

In the dialog box, click the “OK" button.
The voting item is deleted from the agenda file.

To search for a voting item in the agenda file:

In the “Agenda Items” window, click the “Search” button.
The “Item” box turns red.

Click the red “Item” box, enter the number of the searched voting item
and press the "Enter” key.
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If the number is found, the corresponding voting item is highlighted in
the agenda and its data are displayed in the input mask.

To scroll through the agenda file:

EE' In the “Agenda Items” window, click one of the arrow buttons behind
the “Item” box.
The previous or the next entry is displayed in the input mask and the
corresponding voting item is highlighted in the agenda.

To move a voting item to a new item number:

In agenda of the “Agenda Items” window, click the voting item you
want to move.
The data are displayed in the input mask.

M Click the “Move” button.

ove | A green field appears next to the “Item” box.
Enter the desired item number — which must not yet be assigned! - into
the green field and press the “Enter” key.

The selected voting item is moved to the new item number in the
agenda file. The entry in the agenda is moved correspondingly.

Importing voting items

Instead of manually entering voting items, you can import them from a
text file. The text file must have the extension . txt. All voting items must
be separated by carriage returns and all fields must be separated by
semicolons.

The order of the data in the text file:

* Number of voting item (Item) 3
* Number of amendment (Amendment) 2
* Description (Description) 30
* Voting option (Index 1)
* Voting option 2 (Index 2)
* Voting option 3 (Index 3)
e Quorum (Quorum)
* Majority (Majority)

w w w w w

:“Agenda. txt”

001; 01; Election of the chairman; Arc; Bec; Mil 50; 66;
001; 02; Election of the vice chairman; Arc; Bec; Mil 50; 50;
003; 00; Finances; Opl; Op2; Op3 100;50;
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Select import file

To import voting items:

From the “Agenda” menu, choose “Import Agenda”.
The “Import Agenda” window opens.

. Import Agenda Items x|

Import file name:

|C'\Programme\SDCSOOO\S_CM\Data\agenda bt | Selectimport file |

Destination file name:

|C.\Programme\SDC8000\870M\Data\agenda02 |.dia ‘ Select destination file |

Start import |

| Click the "“Select import file” button, select a *. txt file and confirm
your selection by clicking the “OK" button.

Select destination file

The path and the file name are displayed in the field below “Import file
name"”.

| Click the “Select destination file” button, specify the folder and name
of the new agenda file to be created and confirm your selection by

Start import

clicking the “OK"” button.
The path and the file name are displayed in the field below “Destination
file name”.

Click the “Start import” button.
The voting items are displayed in the lower part of the window. An

Agenda
Impon Agenda
Adrministration

Frint

agenda file containing the data of the text file is automatically created
and saved.

Printing an agenda file

To print an agenda file:

From the “Agenda” menu, choose “Print".
The file selection box opens.

Select the agenda file to be printed and confirm your selection by
clicking the “OK" button.
The "“Start Printing?” dialog box opens.

Click the “OK" button.
The selected agenda file is printed.

To automatically add a heading to the printout, see “Configuring the
voting settings” on page 42.
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Viewing, exporting and printing log files

You can create log files for different system events during a conference
(see "Configuring the log files” on page 47).

All log files are saved in a Microsoft Access database (file extension
*.mdb). For each conference, the software automatically creates an mdb
file which is saved in a folder to be specified in the “Path data” box (see
"Selecting the folders for saving the voting results, safety copies and log
files” on page 48). The format of the name of a database is as follows:

LOG_year_month_day_hourminutesseconds.mdb

Example: LOG_2006_10_03_123031.mdb

To export or print the log files of a database:

To open the database of the current conference:
P From the “Logging” menu, chosse”Open Current Database”.

To open a different database:

P Click "Open Database” and then select the desired database.
The database opens.

File:
ChionologicalLOG_roomZ_164
Bariar i ! "
[T 07062008 164101 WicLOG_rooma_164101 o | Detail
Time Event =
p 164101 Honferenz starten: room2
16:45:32 Mikrofone aktiviert: 0004, Charles Letéhvre
16:45:338 Mikrofone deaktiviert: 0004, Charles Lefébvre
16:57:09 Mikrofone aktiviert: 0003, Muhammad lbn Assad
17.21:18 Kanferenz beencen
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The upper table displays all log files created during the conference. (For

how to specify the log files to be created during a conference, see
"Configuring the log files” on page 47.)
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The lower table displays all events recorded in the selected log file. In
the case of a vote log file, the voting result is also displayed. You can
display or hide these events by clicking or unclicking the “Details”
check box.

In the upper table, click the desired log file.

To view a log file:

Click the "Show Report” button.
The log file is displayed. You can scroll through the log file using the
buttons on the menu bar, and you can scale and print the log file.

To print a log file:

Click the "Print Report” button.
The printer driver window opens. Print the file as usual.

To export a log file:

Click the "Export Report” button.
The “Export Report” window opens.

In the white field, enter the name to be assigned to the files to be
exported.

In the “Format” box, click the check boxes of the file formats to be
created.
You can export several formats at the same time.

Click “OK".

The log file is saved in a folder to be specified in the “Path data” box
(see "Selecting the folders for saving the voting results, safety copies
and log files” on page 48).

If you export log files in the HTML format, the software automatically
creates a folder named “X_Files” (where X" corresponds to the file
name chosen by you). If you pass on the HTML files, you have to pass
on the “X_Files” folder too. Alternatively, the “X_Files” folder must be
available online.
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Monitoring and controlling a conference

This chapter provides information on how to monitor a conference, how to
intervene in a conference and how to take votes.

Starting a conference

To start a conference;

P Make sure that all components are connected correctly and that the
central unit is turned on.
The configuration must be error-free (see “Configuring the conference
system” on page 22) and the conference consoles must be initialized
(see “Initializing the conference consoles” on page 37).

Start P From the “Start” menu, choose “Synoptic” or click the “Start” button.
Synoptic | The file selection box opens.

b First select the *.tec file containing the synoptic view of your
conference and confirm your selection by clicking the “OK" button.
A second file selection box opens.

b Select the *.del file containing the names of the delegates and
confirm your selection by clicking the “OK"” button.
If you have not licensed the S-DM software module and thus have no
delegate data, click “Cancel”.

The synoptic view opens and the conference can start immediately.
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The synoptic view shows the console icons.
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To change to the delegate list:

Click the “List" tab.
The delegate list opens.

T

Synoptic  List

L

Dielegates | Floor

Park San. Tak mam

Dilegates |l
0001 Eawakami Hiroko
0002 Hiller Tames
0003 Ibn Assad Mubammad

haxl

DO0Y Miller James

0001 Kawakami Miroko Moda
Rrcher Jenny [T11Y

Becker Martin 000
Ibn Assacd Hubammad LLLE]
Kawakaml Mircko o001 e
o004 0001 maakami He ok
[T
0010

Ullstein Elaus [TFEN
von Loshneisen Patrizia 0000 |
Winter Lars 00T

L
ho Chi rg=Meng 0017

It Requests

D004 Lefebvre Charles

The delegate list shows the names of the delegates.

The synoptic view and the delegate list display the control palette on the
right-hand margin of the screen.

If you move the mouse pointer to the left-hand margin of the screen in the
synoptic view or the delegate list, the tool palette shown on the left is
displayed.

Monitoring and controlling a conference via the control
palette

When a delegate makes a request to speak or a request to speak is
granted, the name of the delegate is displayed in the corresponding boxes
of the control palette — provided you have licensed the S-DM software
module.

To display the name of any desired delegate:

In the synoptic view, position the mouse pointer on the console icon of
the delegate whose name you want to display.

The name of the delegate is temporarily displayed next to the console
icon.

The name of the delegate also appears running across the gray field at
the top of the control palette.

If you have clicked one of the option buttons “Delegate
database”,”Badge name” or “Mix" in the “Automatic Label” box on the
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“Confsys” tab (see “Labelling conference console icons automatically”
on page 46), icon labels with the names of the delegates are displayed
next to the conference console icons — even if you do not position the
mouse pointer on the console icon.

PEE Micon] Micor]  The current time is displayed next to the “Mic On” and “Mic Off" buttons
on the control palette (see “Deactivating all consoles” on page 69 and
""Reactivating the last active console” on page 69).

Mode The conference mode is displayed in the “Mode” box.
WITH REQUEST
In order to view the names of the delegates as described in the following,

you require the S-DM software module.

D001 Becker Martin * The names of all current speakers and their microphone numbers are
automatically displayed in red in the upper yellow box (“Active
Speakers” box).

0002 O'Meil Harman * The names of all delegates who have made a request to speak and their
microphone numbers are automatically displayed in green in the lower
yellow box ("Requests” box).

D001 Becker Martin * The names of all delegates and their microphone numbers are displayed
0002 C'Meill Harman . . I "
0003 hung Rossling in black in the “All delegates” box.
0004 Archer Jonathan
0005 El Saad Ahmed
0006 Xian-Li James

ANNT Craans bliclalss

H#Errors
Micro L} I ~ l

* Inoperable (i.e. wrongly connected or defective) consoles are displayed
in the "#Errors” box. The microphone numbers of the inoperable
consoles are displayed in the drop down list box.

The inoperable consoles are also displayed in yellow in the synoptic view
(see “Monitoring the conference console icons in the synoptic view” on

page 70).

Boniie * The operating states of the interpreter booths are displayed in the
,%M "Booths” box — even if you do not have a license for the S-IM software
17Ha[19/20/21 2223024 module or it is currently not in operation.

e Trife Each interpreter booth is represented by a booth icon displaying the

booth number. The booth number corresponds to the channel number of
the main target language configured. If someone is interpreting via one
of the consoles in an interpreter booth, the booth icon is displayed in
green; if a console in a booth is not active, the booth icon is displayed in
gray.

If you have specified a maximum speaking time for the “Global” option
in the “Speech Timer” box on the “Confsys” tab (see “Configuring the
maximum speaking time” on page 46), different displays and buttons
for limiting and monitoring the speaking time appear in the lower part
of the control palette (see “Using the “Global” option button in the
"Speech Timer” box" on page 69).

* If you have specified a maximum speaking time for the “Single

Ny Delegate” option in the "“Speech Timer” box on the “Confsys” tab (see
HOLD | "Configuring the maximum speaking time” on page 46), a window
containing different displays and buttons for limiting and monitoring
the speaking time appears in the synoptic view (see “Using the “Single
00:59 Delegate” option button in the “Speech Timer” box” on page 69).
STOR |
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To deactivate all active consoles:

Click the "Mic Off” button on the control palette.
All active consoles are deactivated. At the same time, all requests to
speak are cancelled.

This function is e.g. for the quick reactivation of the console of a delegate
whose speaking time is over.

To reactivate the last active console:

Click the “Mic On"” button on the control palette.
The last deactivated console is reactivated.

The green bar shows the countdown of the speaking time. You can control
this speaking time as follows:

To temporarily interrupt the countdown:

Click the “HOLD" button.
The speaker can continue to speak while the countdown is temporarily
interrupted.

To continue the countdown:

Click the "Proceed” button.

To stop the countdown:

Click the “STOP" button.
The countdown stops and the “speaking right” is withdrawn from the
speaker.

To change the preset maximum speaking time:

Click one of the arrows in the “Max. speaking time” box in the lower
part of the control palette.
You can set speaking times of between 1 and 200 minutes.

To start the countdown:

* Click the “START SPEECHTIME" button.

The countdown starts. The green bar shows the countdown of the
speaking time. The clock is displayed and shows the countdown in
seconds.

To temporarily interrupt the countdown:

Click the “HOLD" button.
The countdown is interrupted.
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To continue the countdown:

Click the "CONTINUE" button.
The countdown continues.

To stop the countdown:

Click the “STOP SPEECHTIME" button.

The countdown stops. The clock and the “Max. speaking time” box are
no longer displayed.

The system is now ready to start a new countdown.

Monitoring the conference via the synoptic view

To work with the synoptic view:

Click the "Synoptic” tab.
The synoptic view opens.

The different colors of the conference console icons in the synoptic view
have the following meanings:

* The border color (here: blue) of a conference console icon is selected
when the synoptic view is created — e.g. in order to distinguish different
delegate groups.

* Yellow conference console (2):

The corresponding conference console is defective or not connected
correctly.

* Pink conference console icon (3):

The corresponding conference console is configured as the chairman unit.

* White conference console icon (4):

A chip card is inserted into the chip card slot of the corresponding
conference console.

* Green conference console icon (5):

The delegate has made a request to speak by pressing the microphone
key (%

* Red conference console icon (6):

The delegate has been granted the request to speak.

* Gray conference console icon (7):

The conference console is currently inactive.

Monitoring conference operation via the delegate list

To work with the delegate list:

Click the “List” tab.
The delegate list is displayed.
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Delegates

0001 Kawakami Hiroko
0002 Miller James
0003 Miller James
0004 Lefébvre Charles
0005 Archer Jenny
NNNA Rearlkear Martin

Delegates

Park Sen-Tak o009

Archer Jenny
Becker Martin

Ibn Assad Muhammad
Kawakami Hiroko
Lefebvre Charles

0005
0006
0003
0001
0004

Floor

0002 0'Heill Harman
0001 Becker Martin

ticro Requests

0003 Chung FRosalind

0004 Archer Jonathan

0001 Becker Martin
0002 0'Heill Harman
00032 Chung Rnsalindk

You can also monitor the conference via the delegate list instead of the
synoptic view. The names are displayed in the following boxes:

* The left-hand “Delegates” box lists all delegate names in the order of
their microphone numbers. If you click this box and rapidly enter a four-
digit microphone number, the name of the delegate seated at the
console with this microphone number is highlighted.

* The right-hand “Delegates” box lists all delegate names in alphabetical
order. If you click this box and enter a letter, the first name in the list to
begin with this letter is highlighted.

* The names of all delegates who are currently speaking are listed in red
in the “Floor"” box.

* In the “With request” and "With request no clear” conference modes,
the names of all delegates who have made a request to speak are listed
in green in the “Micro Requests” box.

Intervening in the conference

Once you have activated a console, the following happens:

* In the synoptic view, the icon of the deactivated console turns red.

* The name of the delegate at the activated console appears in the “Floor”
box of the delegate list.

* The name of the delegate at the activated console appears in the “Active
Speakers” box of the control palette.

* The signal light ring and the “Microphone active” LED of the activated
console light up. The delegate can speak immediately.

Depending on the conference mode, you can activate several consoles in
succession — until the speaker limit set in the options is reached.
To activate a console in the synoptic view:

Click the gray console icon of the console you want to activate.

To activate a console in the delegate list:

In one of the two “Delegates” boxes, click the name of the delegate
whose console you want to activate.
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To activate a console on the control palette:

D001 Becker Martin Inthe “All delegates” box, click the name of the delegate whose console
0002 O'reill Harman .
0003 Chung Rozslind you want to activate.

0004 Archer Jonathan

0005 El Saad Ahmed

0008 Xian-Li James

0007 Greene Mickolas

0008 Hohenlohe, won Patrizia
0009 Ibn Al Farrag Mohamme:
0010 Janapstma Ana-Ra Shre
0011 Archer, Prof. Jonathan
0012 Zhou Ching-Meng

Once you have deactivated a conference console, the following happens:

* In the synoptic view, the icon of the deactivated console turns gray.

* The name of the delegate at the deactivated console disappears from
the “Floor” box of the delegate list.

* The name of the delegate at the deactivated console disappears from
the "Active Speakers” box of the control palette.

* The signal light ring and the “Microphone active” LED of the deactivated
console go off. The delegate can no longer speak.

To deactivate a console in the synoptic view:

% Click the red console icon of the active console you want to deactivate.

To deactivate a console in the delegate list:

‘000 Becker Martin ‘ In one of the two “Delegates” boxes, click the name of the delegate

000% Archer Jonathan whose console you want to deactivate or, in the “Floor” box, click the
name (shown in red) of the delegate whose console you want to
deactivate.

To deactivate a console on the control palette:

T001 Becker Martin In the “Active Speakers” box, click the name (shown in red) of the
delegate whose console you want to deactivate.

If a delegate makes a request to speak:

* In the synoptic view, the corresponding console icon turns green.

* The name of the delegate appears in green in the “Micro Requests” box
of the delegate list.

* The name of the delegate appears in green in the “Requests” box of the
control palette.

* The green "“Request to speak” LED on the console starts flashing.

To grant a request to speak in the synoptic view:

Click the green console icon in the synoptic view.
IZ[% The activated console turns red.
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Micro Requests

0003 Chung FRosalind

0004 Archer

Jonathan

0002 O'Meill Harman

Clear Request

Print Request
Microphones

To grant a request to speak in the delegate list:

In the “Micro Requests” box, click the name of the delegate (shown in
green).

The name of the delegate at the activated console moves to the “Floor”
box.

To grant a request to speak on the control palette

In the “Requests” box, click the name of the delegate (shown in green).
The name of the delegate at the activated console moves to the “Active
Speakers" box.

If a delegate has made a request to speak, you can either grant it to him
(see previous section) or reject his request.

To reject the request to speak of an individual delegate:
Change to the synoptic view by clicking the “Synoptic” tab.

In the synoptic view, right-click the green console icon of the delegate
whose request to speak you want to reject.

The green console icon turns gray. The name of the corresponding
delegate disappears from the “Micro Requests” box in the delegate list
and from the “Requests” box of the control palette.

To reject all requests to speak:

Move the mouse pointer to the left-hand margin of the screen.
The tool palette opens

Click the "Clear Requests” button.

All green console icons turn gray. All names disappear from the “Micro
Requests” box of the delegate list and from the “Requests” box of the
control palette.

To print a list of all current resquests to speak:

Move the mouse pointer to the left-hand margin of the screen.
The tool palette opens.

Click the “Print Request Microphones” button, select the printer and
start printing.
The list is printed.

If one of the chairmen changes places during the conference or if another
person becomes chairman:

Activate the synoptic view.
Press the “Ctrl” key and keep it pressed.

At the same time, click the console icon to be configured as the
chairman unit.
The console icon turns pink. The corresponding console is now
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configured as the chairman unit.

If you click the console icon of a chairman unit, its color changes from
pink to grey and the corresponding console becomes a normal delegate
unit.

In order for the chairman to benefit from all possibilities offered by his
status, his console must have the priority key X% ). For this reason,
please make sure that only conference consoles which feature a priority
key % (SDC 8200 C, SDC 8200 CC or SDC 8200 CV) are configured as a
chairman unit!

You have set the speaker limit in the “Max Micro ON"” box on the “CU" tab
(see “Configuring the speaker limit” on page 49). To change the speaker
limit during the conference, proceed as follows:

Max MicroON————— Move the mouse pointer to the left-hand margin of the screen.

{ 3 - The tool palette opens.
1 -
_ From the “Max Micro ON" drop-down list, choose the desired speaker
1 limit (from 1 to 15).
; —
6
7
B -l In the “FIFO"” an "“group 1" to “group 4" conference modes, the speaker

limit is preset and cannot be changed.

To change the volume of the consoles’ built-in loudspeakers:

Move the mouse pointer to the left-hand margin of the screen.
The tool palette opens.

Volume Floor Move the slider in the “Volume Floor" box.
—— The volume changes as soon as you release the slider.

To turn the audio input and outputs of the central unit on and off:

Move the mouse pointer to the left-hand margin of the screen.
The tool palette opens.

alx—————————— In the “AUX" box, click the check boxes of the audio inputs and output
;i m - you want to turn on.
Egﬂg E 23:: To turn an audio input or output on, a tick must appear in the
Cours [ outs corresponding check box. To turn an audio input or output off, NO tick
AUX must appear in the corresponding check box.

You can also turn the audio inputs and outputs on and off as described
in the following section.
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To change the configuration of the audio inputs and outputs during a
conference:

Move the mouse pointer to the left-hand margin of the screen.
The tool palette opens.

In the tool palette, click the "AUX" button.
The "AUX IN/OUT" dialog box opens.

&, AUX IN/OUT x|
~AUX OUT
—AUX OUT 1 —AUX OUT 2 —AUX OUT 3 —AUX OUT 4 ~AUX OUT 5 —AUX OUT &
Wolume olume Wolume Yolume Wolume Yolume olume Wolume
[18° [18° [i8" [i8" [i8" [18 [i8" [pa
Distance Conferencing Channel Channel Channel Channel Channel
© Off - - - -
" On ‘ ’7 1 ’7 ’ ’V ’ ’V . ’7 ’ =
Status Status —— Status —— Status —— Status —— Status
& Off & Off @ Off i« Off @ Off ~ Off
© On © On © 0On  On  0n © On
~AUX IN External Equalizer
~AUXIH1 ~AUXIN2 Status
Level & Of
 On
[18" e
— Sensitivity — | | —— Sensitivity —
 Low  Low
@ High @ High
 Status —— || Status ——
= 0ff i Off
© On ' On - -

Change the configuration of the audio inputs and outputs as desired.
You configure the same settings as in the “AllA-In<Cut.” menu of the
central unit (see “Configuring the audio inputs and outputs” on
page 104 of the SDC 8200 system manual).

* Use the volume sliders to set the volume of the audio signal available
at the corresponding audio output.

* Click the “Off” option button in the “Status” box to turn the
corresponding audio input or output off.

* Click the “On" option button to turn the corresponding audio input or
output on.

You can also turn the audio inputs and outputs on and off as described
in the previous section.
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Channel

* From the “Channel” drop down list, choose the number of the

[0 =] interpretation channel that is to be assigned to the corresponding
audio output. If you choose 0", the floor channel is assigned.
Distance Conferencing * Click the "On" option button in the “Distance Conferencing” box to
(‘fgg prevent echo during remote conferencing (see “Setting up remote
conferences” on page 56 of the SDC 8200 system manual).
~AUXIN1 * Use the level sliders to set the input level of the corresponding audio
Level input.
* Click the "Off” option button in the "Status” box to turn the
corresponding audio input or output off.
Click the “On" option button to turn the corresponding audio input or
output on.
[18~
— Sensitivity —
= Low
& High
—— Status ——
« off
& On
Sensitivity —, * Click the “Low" option button in the “Sensitivity” box to set a low
’7; h?;‘; sensitivity for the corresponding audio input.
Click the “High” option button to set a high sensitivity for the
corresponding audio input.
Change the configuration for an external equalizer as desired.
External Equalizer * Click the “On" option button in the “External Equalizer” box if an
Status —— external equalizer is connected to the central unit.
& Off
© On
If the “On" option button in the “External Equalizer” box is activated,
the central unit outputs the audio signals of the consoles’ microphones
via the audio output and not via the consoles’ built-in loudspeakers.
However, if no external equalizer is connected, no audio signals can be
heard through the consoles’ built-in loudspeakers.
Click the “Close” button.
The configuration of the audio inputs and outputs is changed. All
changes are also displayed in the central unit’s operating menu.
If you change the configuration of the audio inputs and outputs via the
central unit’'s operating menu, this is automatically detected by the
software and immediately displayed in the “AUX IN/OUT" dialog box.
VIP units are marked with a little blue square in the upper left corner of the
conference console icon.
To switch the VIP mode off:
Move the mouse pointer to the left-hand margin of the screen.
The tool palette opens.
In the tool palette, click the “VIP: ON” button.
VIP: ON

The little blue squares disappear from the conference console icons. All
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VIP: OFF

Microphone N° 0004

001 002

| oL

conference consoles configured as VIP units (see "“Configuring VIP
units” on page 36) loose the VIP rights. The button changes to “VIP:
OFF".

To switch the VIP mode on:

P In the tool palette, click the “VIP: OFF"” button.
The blue squares are displayed on the confernce console icons. All
conference consoles configured as VIP units (see “Configuring VIP
units” on page 36) obtain the VIP rights.The button changes to “VIP:
ON".

Displaying the group assignment of a conference console during a
conference

To display the audio group and voting group assignment of a conference
console during a conference:
P> Press the “Ctrl” key and keep it pressed.

P Right-click the conference console whose group assignments you want
to display.
The dialog box for displaying groups opens. The numbers of the audio
group and the voting group to which the conference console is assigned
are displayed.

To close this dialog box:

P Click the “Close” button.

Displaying the overview of groups during a conference

To display the overview of groups during a conference:

P Move the mouse pointer to the left-hand margin of the screen.
The tool palette opens.

P In the tool palette, click the “Group” button.
The “Group Overview" dialog box opens.

» From one of the two drop down lists “Audio Group” or “Vote Group”,
choose the number of the group to be displayed.
The description of the selected group and the group color are displayed.
(You cannot edit the description and the group color in this dialog box.)
In addition, the microphone numbers of all conference consoles
assigned to the selected group are displayed in the “Members” list.

» Click the “Show" button.
In the synoptic view, all conference consoles assigned to the selected
group are highlighted in the group color of the group.

To return to the normal display:

P In the “Group Overview" dialog box, click the “Close” button.
All conference consoles are displayed in their original color instead of
the group color.

Changing the audio settings during a conference

To change the audio settings during a conference:

P Move the mouse pointer to the left-hand margin of the screen.
The tool palette opens.
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Audio Settings

. Audio Settings

In the tool palette, click the “Audio Settings” button.
The “Audio Settings” dialog box opens.

Graup IAII ;|

[ hute &0

x|
- Loudspesl - Microphone
“olume ~Torg———————————— Automatic Gain ~Tone
Bass Micldle Trekle Reduction Bazs  Middle Trekle
B~ |Juws [oeB [oeB [os” [oue— foce— [oce
‘ Default Il I

Group I vl

Standard

Loudzpesaker
“olume

T

Automatic Gain
Reduction

o

78

If you have created audio groups:

From the “Group” drop down list, choose the number of the audio
group whose audio settings you want to change.

The group color is displayed in the field below the “Group” drop down
list and the description of the group is displayed in the field below the
group color field.

To change the audio setting of all conference console icons, choose
“All"” from the “Group” drop down list.
In this case, the group color field and the field displaying the
description of the group remain empty.

In the “Loudspeaker” box, adjust the audio settings for the consoles’
built-in loudspeakers. Here you adjust the same settings as in the
“Loudsreaker” menu of the central unit (see “Adjusting the audio
settings for the consoles’ built-in loudspeakers” on page 89 of the
SDC 8200 system manual).

In the “Microphone” box, adjust the audio settings for the consoles’
microphones. Here you adjust the same settings as in the
“Microrhone” menu of the central unit (see “Adjusting the audio
settings for the consoles’ microphones” on page 90 of the SDC 8200
system manual).

* The “Volume” slider in the “Loudspeaker” box allows you to set the
volume of the consoles’ built-in loudspeakers.

* The “Automatic Gain reduction” slider in the “Microphone” box
allows you to set the automatic gain reduction of the consoles’ micro-
phones.
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* The "Mute All"” check box allows you to mute the conference consoles
of all audio groups.

* The “Low"”, “Middle"”, and “Treble" sliders in the “Tone” boxes allow
you to adjust the bass, middle and treble response of the consoles’
built-in loudspeakers and microphones.

If you change the audio settings via the central unit's operating menu,
this is automatically detected by the software and immediately
displayed in the “Audio Settings” dialog box.

To change the conference mode during a conference:

Make sure that no-one is currently speaking.
When changing the conference mode, all microphones are turned off
automatically!

From the “Mode"” menu, choose the desired conference mode.
The setting becomes effective immediately. The new conference mode
is displayed in the “Mode" box of the control palette.

To save the data of all inserted chip cards in a file (e.g. in order to
document the presence of the delegates), you require the SDC 8200 SYS
software:

From the “Present Badges” menu, choose “Save”.
The file selection box opens.

Select a folder, the file name and the extension “mdb” and confirm your
selection by clicking the “OK" button.

Allinserted chip cards are read and the data are saved in a database file
in the order of the microphone numbers.

"C:\Programs\SDC8200\S_CM\Data\File.mbd", "2004-
01-01","12:00:00",""

"Micro", "Badge", "Name", "Party"
4, 1, "Archer", "USA"
5, 2, "Becker", "GER"
6, 3, "Miller", "CAN"

To print the data of all inserted chip cards:

From the “Present Badges” menu, choose “Print"”.
All inserted chip cards are read and the data are printed in the order of
the microphone numbers.
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To test the loudspeakers of the connected conference consoles:

Test From the “Test” menu, choose “Test Generator ON".
Testgenerator OFF " " . . .
Testgeneratar ON The “Test Generator ON" button is displayed. All active consoles are
e el e e deactivated automatically. The central unit transmits a test tone which

End Test all Microphanes

is reproduced by all operational conference consoles.

Test Generator ON

To end the loudspeaker test:

[Test’ From the “Test” menu, choose “Testgenerator OFF” or click the “Test
Testgenerator OFF Generator ON" button.
T The “Test Generator ON” button disappears and the test tone stops.

Test all Microphones
End Test all Microphanes

To test the microphones of the connected conference consoles:

[Test From the “Test” menu, choose "Test all Microphones”.
Testgenerator OFF The “Test all Microphones” button is displayed.

Tesktgenerator OM
Test all Microphones
End Test all Microphanes

Test all Microphones ‘ 3 ‘

All active consoles are deactivated automatically. All operational
consoles are activated for approx. 1 second each. The microphone
number of the currently active console is displayed on the "“Test all
Microphones” button and the signal light ring on the currently active
console lights up.

To end the microphone test:

Test From the “Test” menu, choose “End Test all Microphones” or click the
Testgenerator OFF "“Test all Microphones” button.
i The “Test all Microphones” button disappears and the microphone test
est all Microphones X
End Test all Microphones is ended.

To create a text message and display it on the displays of the conference
consoles:

Message to Delegates Click the “Message to Delegates” menu.
The “Message to Delegates” window opens.

w. Message to Delegates il

M ge To
" Delegate N* | j
Al delegates

Send message

Clear message
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Start

Send message

Send message

Clear message

Enter the message in the “Message” box.
You can enter a maximum of 40 characters.

Special characters such as accents and umlauts are not displayed
correctly on the displays.
To send the message to all delegates:
Click the “All delegates” option button.
Click the “Send message” button.
The message is sent to the displays of all connected conference consoles.
To send the message to a certain delegate:

Click the “Delegate N°” option button and enter the microphone
number in the field on the right of the option button or select the name
of the delegate from the drop down list box.

Click the “Send message” button.
The message is sent to the display of the selected conference console.

Select the next delegate to receive this message and click the “Send
message” button again.
To clear the message from the “Message” box:

Click the “Clear message” button.
The message is cleared from the “Message” box.

You can use two different acoustic signals, e.g. to announce the beginning
of the conference or the start of the voting session. You can select the
signal via the options (see “Configuring acoustic signals” on page 45).

To trigger an acoustic signal:

In the voting window, click one of the buttons “Bell” or “Start".
The signal is output via the sound card of the PC.
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VOTE

Voting

Note:

All conference consoles have at least three voting keys @, allowing you
to take votes in "1 of 3" mode.

The SDC 8200 CV and SDC 8200 DV conference consoles have five
voting keys ¢B,, allowing you to take votes in “1 of 3" and “1 of 5"
mode.

In order to be able to take votes in “1 of 5 mode, you require the
SDC 8200 SYS software.

Loading the agenda file

To start a vote or a series of votes:

> Move the mouse pointer to the left-hand margin of the screen.
The tools palette opens.

P Click the “VOTE" button.
The file selection box opens.

b Select an agenda file and confirm your selection by clicking the “0OK”
button.
The voting window opens.

[ 14:52:58 0001 Kawakami Hirocko
Votelabel PG Votelibl €L 0002 Miller James
Eotitled taVato: | 3
O [Favauable [ves <[ 2 Voted: [ 3 )
W I‘*”_J ‘>,T Mot Voind : o Irem [:I Amend, |:| +* I Qunrum % %
S | - iy 0] %
Cantra == 1
W o1 o
Result
Toatvess [ 3| | APPROVED WITH
MAJORITY
| Next ltem | Agenda
[Elechons
20
b V54 [ Do Sive
W WO | 20k
~3nme
200
05 o™
o
| | 2
T = S Vita Vo Pretm v T vty ]
¥ ithout Badge | (¥ Cai 1ot ¥ Printer OFF " on Syt detl
START VOTING |[a<] v ose | Con s Carcon | Gon f et
Click for Synopic View e T
Clnar Vote Resuls :m :: ::
Reprint Vata

The left-hand side of the window shows:

* the current time of the current voting item,

* the name of the three or five voting options (colors/abbreviations on
the displays of the conference consoles) and the voting result in
numbers,

* a graphic representation of the voting result (circle or bar graph).
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The right-hand side of the window shows:

* ayellow box in which the names of the delegates who make a request
to speak are shown in green (if you click one of the names with the
left mouse button, the corresponding delegate is assigned the
"speaking right"),

* if specified — two logos which appear one above the another (on the
top right) (see “Configuring the voting settings” on page 42),

* the “Next Item” and the “Agenda” buttons and
* the loaded agenda file (Agenda).

The lower part of the window shows:

* the buttons for starting and ending the votes (on the left) and
* the voting settings (on the right).

Changing the agenda

You can change the agenda until shortly before the vote starts:

P Click the "Agenda” button.
The agenda opens.

&, C:\Programme\SDC8000%5_CH\Databagenda.dia x|

File End
e oo ] (4]
Amendment :

Descrip‘rion |Election of Chairperson

pee [ )6

sl s2 =53
sl s2 =3
003 01 Finances, amendement 1 sl s2 =3
003 02 Finances, amendement 2 sl s2 =3
003 03 Finances, amendement 3 sl s2 s3
004 00 Salaries s1 s2 s3

Add

m
=
o
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Group —

Bacge
% Without Badge
£ With Badge

Bacge
£ Without Badge
{* yith Badge

Secret —
" OFF
e Oh

Secret —
% \OFF
0N
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Selecting the voting settings

To restict votes to certain conference participants, you first have to define
voting groups as described under “Defining groups” on page 34.

From the “Group” drop down list, choose the number of the voting
group which is to participate in the vote.

To allow all participants to participate in the vote, choose “All” from the
“Group” drop down list.

To restict votes to conference participants owning a chip card, you require
the SDC 8200 SYS software.

To take votes without chip cards:

In the “Badge” box, click the “Without Badge" option button.
The delegates can cast their vote without a chip card.

To take votes with chip cards:

In the “Badge” box, click the “With Badge” option button.

The delegates can only cast their vote when their chip cards are
inserted into the chip card slots of their conference consoles and the
green LED on the chip card icon lights up.

To take a secret vote:
In the “Secret” box, click the “ON" option button.

* If you click the “Synoptic detail” option button, the selected voting
option (YES, ABS,NOor 1,2, 3,4,5)is displayed in the synoptic
view.

* After a delegate has cast his or her vote, all LEDs on his or her console
light up so that can see how he or she has voted.

* If you automatically print the voting results (see “Automatically
printing the voting results” on page 85), the printout does
contain information on the delegates.

* The voting protocol files (which are automatically saved in the folder
"C:\Programs\SDC8200\S_CM") do not contain information on
the voting behaviour of the individual delegates.

To take a public vote:
In the “Secret” box, click the “OFF" option button.

* If you click the “Synoptic detail” option button, the selected voting
option (YES, ABS, NO or 1, 2, 3, 4, 5) is displayed by color in the
synoptic view.

 After a delegate has cast his or her vote, the LED corresponding to the
voting option lights up on his or her console so that can see
how he or she has voted.
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* If you automatically print the voting results (see “Automatically
printing the voting results” on page 85), the selected voting option
(YES, ABS, NO or 1, 2, 3, 4, 5) appears next to the name of the
delegate on the printout.

* The vote log files (which are automatically saved in the folder
"C:\Programs\SDC8200\S_CM") contain information on the
voting behaviour of the individual delegates.

To select the voting mode "1 of 3":
Vote Made — In the “Vote Mode” box, click the 1 of 3" option button.
’7(‘: o The delegates can vote “Yes” or “No” or abstain.
of 3
To select the voting mode "1 of 5"

In order to be able to take votes in “1 of 5” mode, all conference
consoles used must have five voting keys @ (SDC8200CD or
SDC 8200 DV). In addition, you require the SDC 8200 SYS software.

Wate Made — In the “Vote Mode” box, click thee 1 of 5" option button.
’7? o The delegates have the choice of five options.

To automatically print all voting results:

Make sure that the printer is connected and configured correctly and

turned on.
Frinter In the “Printer” box, click the “ON" option button.
;mg:g? After the vote is completed, the voting result is printed automatically.
To suppress the automatic printing of the voting results:
Prirter In the “Printer” box, click the “OFF" option button.
;mj o After the vote is completed, the voting result is not printed. However,
you can seperately print the voting result of any vote at any time (see

"Printing voting results” on page 90).

To display how votes are cast:
— Resl Time oting — In the “Real Time Voting” box, click the “ON" option button.
(‘:OFF The display of the votes already cast is continuously updated until
o voting ends. If the delegates can see this display (e.g. via the video PC),
this could influence their voting behaviour.
To prevent that the votes already cast are displayed during voting:

Echizefabstimmung | In the “Real Time Voting” box. click the “OFF"” option button.

* Aus
" Ein
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You can specify a fixed voting time. If delegates do not vote during this
time, their votes become invalid.

To specify a fixed voting time:

Vate with Timer — In the “Vote with Timer” box, click the “ON" option button.
&~ OFF
0N

HoLD The “Max. voting time" list box and the clock are displayed.

§ Sec Click one of the arrows in the “Max. voting time” list box to specify the
(9 voting time (in seconds).

Start the vote (see "“Taking votes” on page 88).
The countdown begins. The green bar turns gray one section at a time.
The clock is displayed and the countdown is shown in seconds.

To temporarily stop the countdown:

HoLD | Click the “HOLD" button.
The countdown is stopped. The delegates can also cast their votes
while the countdown is on hold.

To continue the countdown:

Click the “CONTINUE" button.
The countdown continues. Votes cast after completion of the voting
time are invalid.

i

CONTIMUE

To not limit the voting time:

Vote with Timer — In the “Vote with Timer” box, click the “OFF" option button.
g o Voting does not end until you click the “STOP VOTING” button.

To configure the display style on the video PC:

Start the vote (see "“Taking votes” on page 88).

During voting, a bar chart always appears on the monitor, large screen
display or projector connected to the video PC. The bar chart is only
continuously updated during voting if the “ON" option button in the
“Real Time Voting” box is selected.

Display After the vote is completed, click the desired option button in the
% Synoptic detail e "
" Bar-chart DISp|ay box.
" Momiritif
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* If you select “Synoptic detail”, the synoptic view of the conference is
shown on the video PC. Each console icon is marked with a color
symbolizing the vote cast. A palette on the right-hand margin shows
what the colors mean.

+1%5_CTRata | Seskerali Yorstandskeaderenzies — 16\5_CMData) Telinehmer Yorstandkonferenzdel |
End

0001 0003 Quorum = 50% Majority = 51% [ 10:45:26 |
Election of Chairperscn

* If you select “Bar-chart”, the voting result is shown as a bar or circle
chart on the video PC. The votes cast for one option and the total
votes cast are also displayed as a number.

[Sewssocsoon x

End

0001. Election of Chairperson
Amendment: 0003

| [Favoursble  [E5 > 1 5
[Abstain — [mEE o 1 i,
-k_:ont'm TEES 1 (L]
(L}
TotalVotes: 3 :: P
1 m"
Entitled to Vote : 3 05
Quorum: 50% o4
Majority 57 % =
L5
Voted: 3 o1
Quorum : 2 w
Not Voted : 0

Result APPROVED NO MAJORITY g
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* If you select “Nominatif”, the names of all delegates and the votes
they cast are displayed in clear text.

RI=E
End.
Peint: (00010003
Firction of Chairprraon
Description: ‘

Object: | [ |
lArcher Jenny Not Voted
Backer Martin Hot Voted
Kawakami Hircko Favourable
Lafabvra Charlas Hat Votad
Miller James Abstain
Miller James Contrary
Hakamura Hiroshi Hot Voted
Park Sen-Tak Not Voted
Ullstein Klaus Hat Vatad
von Loehneisen Patrizia Hot Voted
Winter Lara Hot Voted
Zhou Ching-Meng Hot Voted

Taking votes

To start a vote:

Load the desired agenda file (see “Loading the agenda file” on
page 82).

Make sure that all options are configured correctly (see “Selecting the
voting settings” on page 84).

In the agenda, click the vote to be started.

Click the “START VOTING"” button.
START VOTING

The signal light in the “summary” area turns green. If a video PC is
connected, the signal light turns green here too as a signal to the
delegates that they are now expected to vote (see “Configuring the
display of the voting results on the video PC"” on page 86).

The displays of the consoles with voting function display the voting
modes “Vote 1 of 3" or “Vote 1 of 5"

Mic M. 1624 Mic M. 1824
WOTE 1 OF 3 WOTE 1 OF 3
YES ABS HO 1 2 3 4 &

If the “Vote with timer ON" option is selected, the countdown begins
(see "Using the “Global” option button in the “Speech Timer” box" on
page 69).

Aslong as voting is still in progress, the delegates can change their vote
whenever they want!
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STOP VOTING

Dizplay Style -

20 Pie
3D Pie
" 20 Bar

(3D Bar

Clear Vote Results

Click for Synoptic View

A vote is ended:
* automatically when the countdown is over,

* manually if you click the “STOP VOTING" button.

After the vote is completed:

* the agenda displays an “x" in front of the voting item which has just
stopped and the latter automatically moves to the end of the agenda,

* the summary shows the votes cast for all available options as well as the
total votes cast,

* the voting window displays a chart which illustrates the voting result
(you can change the style of this chart at any time by selecting a
different option in the “Display Style” area),

* the voting result is displayed on a video PC (if connected),

* the displays of the consoles display the votes cast for the available
options (see “Configuring the display of the voting results on the video
PC” on page 86),

* the voting result is printed automatically if the “Printer ON" option is
selected (see "Automatically printing the voting results” on page 85),

* the safety folder (see “Configuring the log files” on page 47) saves two
protocol files which contain all voting details — including the voting
result.

To delete the display of the voting result on the master PC and all
connected video or slave PCs:

Click the "Clear Vote Results” button.

All that is deleted is the of the voting results. The saved
protocol files with the voting results are deleted. The system is now
ready for voting again.

To see which vote a certain delegate cast:

Itis only possible to assign the votes cast to the delegates if the “Secret
OFF” option button is selected (see “Taking secret or public votes” on
page 84).

Click the "Click for Synoptic View" button.

The synoptic view is displayed. The console icons appear in the color
which corresponds to the vote cast (see also the color legend in the
summary).

You can display further details on a connected video PC (see
"Configuring the display of the voting results on the video PC" on
page 86).
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To exceptionally print a voting result from a series of votes:

Click the "“Reprint Vote” button.

Reprint Vote h .
The file selection box opens.

Select the voting results to be printed and confirm your selection by
clicking the “OK"” button.
The selected voting results are printed.

To automatically print each voting result:

Click the “Printer ON” option button (see “Automatically printing the
voting results” on page 85).
The voting result is automatically printed after the vote is completed.

To repeat a vote:

In the agenda, click the vote which has already been taken and which
you want to repeat.

Press the “Del” key.
The “x" in front of the vote which has already been taken disappears.

Click the “START VOTING" button again.
START VOTING The vote is repeated.

Once you have completed a vote from the agenda, you can automatically
proceed to the next voting item on the agenda using the “Next Item”
button.

Click the "Next Item” button.
Next Item The subject and details of the voting item at the very top of the agenda
are displayed in the status area on the top left of the voting window.
You can start this vote immediately by clicking the “START VOTING"
button.
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End

Ending the “Confsys” program

To end the “Confsys" program:

Click “End"” on the menu bar.

The program is ended. If consoles are active when you exit the program,
they remain active. The conference is not interrupted, but is now
controlled via the central unit only.

91



Configuring the interpretation system

Configuring the interpretation system

This chapter provides information on how to quickly and easily configure
the consoles of your interpretation system (but not the consoles of the
conference system) using the software.

For configuring the interpretation system, you require the S-IM
(Interpreter Management) software module which is started as follows:

Click “Start” and select “Programs”, “SDC 8200"” and "S_IM" one after
the other. The click “Intsys”.
The “Interpreter Management” window opens.

=1alx|

@ Message

| 21062006 | 11:47 | Connected y

The “Interpreter Management” window consists of:

¢ the menu bar

File Run Updste Message Language Help Bt

* the buttons

To open an To monitor the To change the To send text

interpretation status of the language for the  messages to

configuration: interpreter B-channel: displays of the
consoles during interpreter consoles:

the conference:

Open }
Configuration Bun ‘

Update ‘ @ Textmeldung

* the status bar
(displays the date, the time and the status of the COM connection)

| 06.062006 | 11:02 [ Disconnected |
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[File
New...
Open...
Sawve...
Sawve As..
Close

Delete

Options

Lock Application

Creating an interpretation configuration

To create a new interpretation configuration:

From the “File” menu, choose “New...".
The "“Create new configuration” window opens.

5
MNew Configuration
REmek II Cancel |

Description : I

In the “Name" field, enter the name of the interpretation configuration
to be created (eight characters max.).

In the “Description” field, enter a description of the interpretation
configuration to be created.

Click the “OK" button.

A subfolder with the name of the interpretation configuration is
created in the folder “C: \Programs\SDC8200\S_IM" and all data
of the configuration are saved in this subfolder.

The “Configuration Options" window opens.

Configuration Optiong 4D I
General 0K
Cancel |
Number of booths : I] .l Booths |Desks
i:  E
Artafl
" Disable
* Enable
Mode | hooths
" Mixed
+ Override

" Toggle Override

Mode in booths
" Mixed
&~ Toggle Override

From the “Number of booths” drop down list box, select the total
number of interpreter booths in your configuration:

* If you are using the SDC 8200 software, you can manage up to 28
languages.

* If you are using the SDC 8200
four languages.

For each booth, a row is added to the table on the right.

software, you can only manage
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Cabines

Pupitres |

1

I‘_.h.h

2
3
4

W -0 e

=~

[File”

TN enwy...
Open...
Sawve...
Sawve As..
Close

Delete

Options

Lock Application

Open
Configuration

In each row of the table, click the “Desks” column.
The “Desks” drop down list box opens.

From each “Desks” drop down list box, select the number of interpreter
consoles installed in the corresponding booth.

* If you are using the SDC 8200 SYS software, you can manage up to 28
languages.

* If you are using the SDC 8200 SYS-M software, you can only manage
up to eight languages.

Configure the following options according to your conference
requirements:

¢ Autofloor
* Mode between booths
¢ Mode in booths

For information on the auto-floor function, see “Enabling the auto-
relay interpretation function (Auto-floor)” on page 100 of the
SDC 8200 system manual; for information on the operating modes
between or within the interpreter booths, see “Configuring the
operating mode between booths” on page 97 and “Configuring the
operating mode within a booth” on page 98 of the SDC 8200 system
manual.

Click the “OK" button.
The “Desk Language Assignment” window opens (see "Assigning
languages to the interpreter booths” on page 95).

Opening an interpretation configuration

To open an existing interpretation configuration:

From the “File” menu, choose “Open..” or click the "Open
Configuration” button in the “Interpreter Management” window.
The “Open Configuration” window opens.

Configuration | Configuration Hame Configuration Description |
1| CONFIM CONFERENCE gk |
2|Maxt 8 BOOTHS 2 DESKS EACH
3/MINI 2 BOOTHS 1 DESK EACH Cancel |

Click the configuration you want to open and confirm your selection by
clicking the ""OK" button.

The “Desk Language Assignment” window opens (see "Assigning
languages to the interpreter booths” on page 95).
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[File”
[N ew...
Open...
Sawve...
Sawve As..
Close

Delete

Options

Lock Application

Deleting an interpretation configuration

To delete an existing interpretation configuration:

» From the “File” menu, choose “Delete”.
The “Delete Configuration” window opens.

Confi i6n| Nombre Confi ign D ipcién Confi
i CO 0
2 MAXI 8 BODTHS 2 DESKS EACH
3 MEGA 6 BOOTHS 6 DESKS EACH
4 HINI 2 BOOTHS 1 DESK EACH
5 TEST TEST CONFIGURATION

Borrar Config. |

Salir |

b Click the configuration you want to delete and click the “Delete”

button.
A dialog box opens.

» Confirm the deletion of the selected configuration by clicking the “OK”

button.

The subfolder with the name of the interpretation configuration is
deleted from the folder “C:\Programs\SDC8200\S_IM" and all

parameters of the configuration are deleted.

Assigning languages to the interpreter booths

After you have created or opened an interpretation configuration, the

"Desk Language Assignment” window opens.

Desk 1

T
Craeersd  Hone

Language Ilngli:.n | Come

Goiman CHone |15 Gernan
| Duach “Geme [0 Gernan

| ko M channet
88 Dutch

W

A
¢ B ehannel Dask 7|
= o
T —— - 2 |-
annk. “an s Fremch =

Desk

CSoma |02 Gresk
= Al 03 French

A
B chsannel
~Mone -||rz Greek

ek,
=l
=l

GAC | Geesk -
ZROG2006 | 1335 | Disconnncted
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Abbr. R

Language |Afar

s

Abbr. Language s
AAR Afar s
ABK Abkhazian

ACE Achinese

ACH Acoli

ADA Adangme

AFA Afro-Agiat

AFH Afrihili

AFR Afrikaans |

Delete

Channel

2 | English

3 | French

4 | Italian

5 | Spanish
6 | Dutch

¥ |Japanese
8 | Russian

Autofloor

Language

RROOOooOo

The “Desk Language Assignment” window contains:

* the language table (on the left),
* the booth table,
* the interpreter console boxes (“Desk 1", “Desk 2", etc.) and

* the “Send”, "Reset”, "Deskinit”, "Options” and "Serial Numbers”
buttons (on the right).

The language table contains the languages and their assigned
abbreviations. After initialization, the abbreviations are displayed on the
displays of the interpreter consoles. You can edit the language table.

The abbreviations and names of the languages comply with ISO 639.2.

To add languages and abbreviations to the language table:
Click an empty row at the bottom of the table.

In the “Abbr.” field, enter the abbreviation for the language (three
characters max.) which is to be displayed on the consoles’ displays.

In the “Language” field, enter the name of the language (ten
characters max.).
The language is added to the language table.

To change a language or abbreviation in the language table:

Click the row you want to change.
The abbreviation and the name of the selected language appear in the
“Abbr.” and “Language” fields.

Change the abbreviation and the name of the language in the “Abbr."”
and “Language” fields.

To delete a language or abbreviation from the language table:

Click the row you want to delete.
The abbreviation and the name of the selected language appear in the
“Abbr.” and “Language” fields.

Click the “Delete” button.
The language is deleted from the language table of this configuration.

To assign an interpreter booth its main target language (A-channel):

In the booth table, click the booth to which you want to assign its main
target language.

The channel number of the selected booth is displayed in the “Channel”
field. A drop down arrow for selecting the language appears in the
“Language” column.

Click the drop-down arrow in the “Language” column and select the
language you want to assign to the selected booth.

The selected main target language is displayed in the “Language” field
and in the “Language” column of the booth table.

The channel number and the abbreviation for the language are
displayed in the upper right corner of the interpreter console display
next to the channel key “A".
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Delete

Desk 1

¥ None
" Some
Al

To change the language assignment for the A-channel:

In the booth table, click the booth whose main target language you
want to change.

The channel number of the selected booth is displayed in the “Channel”
field and the language is displayed in the “Language” field. The drop
down arrow for selecting the language appears in the “Language”
column.

Click the drop down arrow in the “Language” column and select the
new main target language you want to assign to the selected booth.
The selected language is displayed in the “Language” box.

To delete the language assignment for the A-channel:

In the booth table, click the booth whose main target language you
want to delete.

The channel number of the selected booth is displayed in the “Channel”
field and the language is displayed in the “Language” field. The drop
down arrow for selecting the language appears in the “Language”
column.

Click the "Delete” button.
The language assignment is deleted and the selected booth is no longer
assigned any language.

Apart from the main target language (A-channel), you can preconfigure a
second target language (B-channel). The interpreters can change the
configuration of the B-channel at any time during the conference (see
"Configuring the B-channel of an interpreter console” on page 38 of the
SDC 8200 system manual). You can also change the preconfiguration of
the B-channel during the conference (see “Changing the language for the
B-channel of an interpreter console during the conference” on page 108).

To preconfigure the second target language (B-channel) of an interpreter
console:

In the booth table, click the booth whose interpreter consoles you want
to assign a specific language for the B-channel.

The interpreter console boxes of the interpreter consoles installed in
this booth are displayed.

In the desired interpreter console box, click the ”“B channel” box.
The “B channel” dialog box opens.

B channel Desk 1

B channel Channel B channel

" Mone [02 Greek | [05 cerman |
* Some 83 French

Al 84 Ttalian

86 Dutch

EN BN X
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The "B channel” dialog box contains the “B channel” box on the left, the
“Channel” and "B channel” lists and — on the right — the check boxes for
activating the other interpreter consoles installed in this booth. The
arrow buttons in the middle allow you to move the languages from one
list to the other:

* Click the > | button to move the first language from the “Channel” list
to the “B channel” list.

* Click the [»2] button to move all languages from the “Channel” list to
the “B channel” list.

* Click the [<] button to move the first language from the “B channel”
list back to the “Channel” list.

* Click the [<<] button to move all languages from the “B channel” list
back to the “Channel” list.

To assign an interpreter console one or several languages for the B-
channel, add the desired languages to the “B channel” list:

B channel - In the “B channel” box, click the “Some" option button.
" None
* Some
Al
In the “Channel” list, click the languages you want to add to the
63 Erench 02 English “B channel” list one after the other or click one of the buttons[>]or [>2].
o4 Itali " o -
65 spanish The selected languages are moved to the “/B channel” list. The selection
86 Dutch is displayed in the corresponding interpreter console box.
B channel Desk 3 B channel Desk 3
None £ None
“Some |{EMHIRED *Some |EMHIEIEN
Al 86 Dutch Al 86 Dutch

Via the interpreter console, the interpreter can now select a language
for the B-channel from the “B channel” list (see “Configuring the B-
channel of an interpreter console” on page 38 of the SDC 8200 system
manual).

Languages which are not in the “B channel” list cannot be selected for
the B-channel.

If you only add a single language to the B channel” list, the interpreter
can only select this language for the B-channel.

To remove languages from the “B channel” list:

In the “B channel” list, click the languages you want to remove one
after the other or click one of the buttons [<] or [«<].
The selected languages are moved back to the “Channel” list.

To assign an interpreter console all available languages for the B-channel:

B channel - In the B channel” box, click the "All"” option button.
(‘:g:;z All languages are moved to the “B channel” list and are displayed in
Al grey.

The interpreter can now select any of these languages for the B-
channel via the interpreter console (see “Configuring the B-channel of
an interpreter console” on page 38 of the SDC 8200 system manual).
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B channel -
" None
* Some
Al

B ch Desk 3
" None 85 German
“Some |{EMETRED]
Al 86 Dutch

(A5 German

86 Dutch

— B ch 1 Desk 3
" None 85 German

(8% German
86 Dutch

— B ch | Desk 3
"~ None 85 German

Desk 1

Al

B ch "
¥ None
" Some

To prevent that the interpreter interprets into a second language, you can
block the B-channel:

In the “B channel” box, click the “None" option button.
All'languages are moved to the “Channel” list and are displayed in grey.

The interpreter can no longer select a language for the B-channel via
the interpreter console. He can only interpret into the main target
language (A-channel).

To assign the selection made to several interpreter consoles of the selected
booth:

In the right hand part of the “B channel” dialog box, click the check
boxes of the interpreter consoles to which the selection made is to be
assigned. To assign the selection made to all interpreter consoles of the
booth, click the “All"” button.

To specifically assign an interpreter console a single language for the B-
channel:

In the corresponding interpreter console box, click the “All"” option
button.
The list box for selecting the language is displayed.

In the list box, click the language you want to assign to the B-channel
of the selected interpreter console.

The language is displayed in the box above the list box and is assigned
to the B-channel of the selected interpreter console.

To prevent that the interpreter selects a different language for the B-
channel:

In the corresponding interpreter console box, click the “All"” option
button.
The list box for selecting the language is displayed.

In the interpreter console box, click the “Some” option button.

In the list box, click the language whose selection you want to prevent
and click the “Delete” button. Repeat for additional languages if
necessary.
The languages are deleted and can no longer be selected by the
interpreter.

To completely deactivate the B-channel:

In the corresponding interpreter console box, click the “None” option
button.

The selection of a language for the B-channel via this console is no
longer possible.
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[File
New...
Open...
Sawve...
Sawve As..
Close

Delete

Options

Lock Application

Sariol Communications Port

Choose the serial communications po which will be vsed on
the PL to connect to the central unit.

COM - [ =

Language
Choose the language of the application,

[Enalish B

Change Password

100

COM port, menu language and password

To configure the COM port and the menu language or to change the password:

From the “File” menu, choose “Options”.
The “Options” window opens.

~Serial Communications Port

Choose the serial communications port which will be used on
the PC to connect to the central unit.

COM : 1 j

rLanguage

Choose the language of the application.

English j

-Password

The password can be changed here.

Change Password

To configure the COM port of the PC connected to the SDC 8200 CU central

unit:

From the “COM” drop down list box in the “Serial Communications
Port” box, select the COM port of the PC connected to the COM 3

interface of the central unit.

To change the menu language of the IM software module:

From the drop down list box in the “Language” box, select the desired

menu language.

To change the password:

Click the “Change Password" button.
The “Change Password” dialog box opens.

Change Pa

~Change Password

Old password :
MNew Password :

Confirm New Password :

Cancel |
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[File”

TN enwy...
Open...
Sawve...
Sawve As..
Close

Delete

Options

Lock Application

INew...
Open...
Sawve...
Sawve As..
Close

Delete

Options

Lock Application

@@ Send

In the “Old Password” box, enter the current password (see “The two
passwords” on page 12).

In the “New Password" box, enter the new password.
In the “Confirm Password"” box, re-enter the new password.

Click the “OK" button to save the new password; click the “Cancel”,
button to keep the current password.

Locking the Interpreter Manangement software

If you need to leave your PC during a conference, you can secure your
interpretation configuration and prevent unauthorized use by locking the
software:

From the “File” menu, choose "Lock Application”.
The password dialog box opens.

Enter the password and click the “OK" button.
The Interpreter Management software is locked.

To unlock the Interpreter Management software:

From the “File” menu, choose “Lock Application”.
The password dialog box opens.

Enter the password and click the “OK" button.
The Interpreter Management software is unlocked.

Initializing the interpreter consoles

After your interpretation configuration has been created and all options
have been set, you first have to transmit the configuration to the central
unit and then initialize the interpreter consoles.

To transmit the configuration to the central unit:

In the palette, click the “Send” button.
The “SDC8200 S-IM" dialog box opens.

SDCE000 S-1M |

@ This action will deactivate the active booths, Do you want bo continue?

Yes | Ma |

Click the “Yes" button.
All active interpreter consoles are deactivated and the “Sending” info
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box appears. The configuration data are transmitted to the central unit.

Sending ... CONFERENCE

Sending ...C:\Programme\SDC8000\S_IM\booth.cha

To initialize the interpreter consoles:

% Click the “Reset” button.
Reset " "o
The “Are you sure ?” dialog box opens.
SDCB000 S-1M =]
@ Are you sure 7
Tes | Mo |

Click the “Yes" button.
Your interpretation system is now ready for operation, if, compared
with the previously transmitted and initialized configuration:

* only the languages assigned to the booths, the modes between or
within booths or the options have been changed,

* the number of booths has not been changed,
* the number of consoles per booth has not been changed.

The following operating steps are only nexcessary if:

* the number of booths and/or
* the number of consoles per booth has been changed.

@ Deskint In the palette, click the “Deskinit” button.
The “Initialize Units" dialog box opens.

AdmIUnit Stop Init Exit

To initialize all interpreter consoles (e.g. when initializing the
interpretation system for the first time or after rearranging the system):

0 Click the “Full Init” button.

The signal light rings on all interpreter consoles start flashing and the
displays of the consoles show the booth number (Booth) and the desk
number (Desk) which will be assigned when you press the MICRO key:

Fu|+|nit

Fresz Mic to confirm

BOOTH DESE
1 1
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Exit

Exit

Options

Toi

Ch

You can manually change the booth number and the desk number on
the interpreter console (see “Manually assigning an interpreter console
an individual booth number” on page 101 and see “Manually assigning
an interpreter console an individual desk number (interpreter console
number)” on page 102 of the SDC 8200 system manual).

of
of

Start initializing the interpreter consoles by pressing the MIC key
interpreter console 1 in booth 1, continue by pressing the MIC key
interpreter console 2 in booth 1, and so on.

The signal light ring of the corresponding interpreter console goes off.

After you have pressed the MIC key
the “Stop Init"” button in the palette.

on all interpreter consoles, click

In the palette, click the “Exit"” button.
Your interpretation system is now ready for operation.

nitialize newly added interpreter consoles:

Click the “Add Unit"” button.
The signal light rings on all interpreter consoles start flashing.

One after the other, initialize the newly added interpreter consoles by
pressing their MICRO key.
The signal light ring of the corresponding interpreter console goes off.

After you have pressed the MIC key
the “Stop Init” button in the palette.

on all interpreter consoles, click

In the palette, click the “Exit"” button.
Your interpretation system is now ready for operation.

anging the options later on

To change the options (modes between or within booths, number of booth
or number of consoles per booth) later on:

In the palette, click the “Options” button.
The “Configuration Options” window opens.

Configuration COptions 40 x|
General OK
Cancel |
Number of booths : I] .l Booths |Desks
1: B
Autafl
" Disable
* Enable
Mode | hooths
" Mixed
+ Override

" Toggle Override

Mode in booths
" Mixed
&~ Toggle Override
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104

Serial Numbers

Change the options and click the “OK" button.
The “Desk Language Assignment” window opens.

Displaying the serial numbers of all connected
interpreter consoles

To display the serial numbers of all connected interpreter consoles:

In the palette, click the “Serial Numbers" button.
The “Serial numbers” window opens.

Interpreter desk serial numbers

=1oix|

~Serial Numbers

show you where which desk is located. This can be helpful in diagnosing the system.

These are the serial numbers of the interpreter units known to the system. These serial numbers

Booth Desk1 Desk 2 Desk 3 Desk 4 Desk b ‘Desk ] Desk 7

Desk 8

00084201 000814e1 0008e001 00081eel 00010101 00080001 00081011 O00084el”
2| 0008004e 0008114e 0008elde 0008001e 0008114e 00080041 0008104e 0008104¢

Exit

The serial number of each connected interpreter console is displayed.
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Message

@ Textmeldung

Intervening in the interpretation system

During the interpretation session, you can:

* send text messages to the interpreter consoles,
* monitor the status of all interpreter consoles,
* change the language for the B-channel of an interpreter console.

Sending text messages to the interpreter consoles

To create text messages and send them to the interpreter consoles:

Click “Message” on the menu bar click the “Message” button in the
“Interpreter Management” window.
The “Message” window opens.

-rMessage
Line 1 I j
Line 2 I j E‘a'
¥ Automatically add age to ages list Messages
~Send to <
E=1
Booth : Al - =nd
Desk : Al -
Exit

Enter the message in the “Line 1 and “Line 2" boxes. You can enter up
to 20 charcters per box.

Alternatively, you can select a message from the message list by
clicking the arrow of drop down list box.

Inthe “Send to" box, click the “Booth” drop down list box and select the
number of the booth to which you want to send the message.

In the “Send to” box, click the “Desk” drop down list box and select the
number of the interpreter console to which you want to send the
message.

To automatically add a newly created message to the message list:

Click the “Automatically add message to messages list” check box.
When you send the message, it is automatically added to the message
list.

Click the “Send" button.

The message is sent to the selected interpreter console(s). The yellow
"Message” LED on the corresponding console(s) lights up. The
interpreter can read the message while pressing the “Message” key
and keeping it pressed. Please note that there is no feedback as to
whether the message is actually read.
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To manage the message list:

] Click the “"Messages” button.
Ed The “Message History” window opens.

Messages

Message History x|

~Line 1
I rActions

Add
Remove |

Cancel |

rLine 2
| - Actions

Add
Remove |

From the “Line 1" or “Line 2" boxes, select a message by clicking it.

To edit a line from the message list:

Click the line you want to edit.
The text is displayed in the box above the list.

Edit the text.

Click the “"Add"” button.

Add
The edited line is added to the message list.

To delete a line from the message list:

Click the “Remove" button.
The line is deleted.

Remove

[

To add a new line to message list (without sending this line):
Enter the text in the “Line 1" or “Line 2" box.

Click the “Add"” button.

Add
The new line is added to the message list.
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Monitoring the status of all interpreter consoles

To monitor the status of all interpreter consoles:

Choose “Run” from the menu bar or click the “Run” button in the
“Interpreter Management” window.
The “Run” window opens.

Status of the booths

Booth|A Channel |Desk [A/B [Act lang. |Autofl[Miz_[Quality Relay | Desks
01] 01 DEU 1A  01DEU - oo [1[2]3]4]s]E
02| 02 ENG 1A | U02ENG . oo [1[2[3]a]s]6
03| 03 FRA 1[2]3]4[5]6
04| 04 1TA 1]2[3]4]8]s6
05| 05 ESL 1(2[3[4[5]6
06| 06 DUT BN 2]314[s[s6

The channel table displays for each channel:

* in the “A Channel” column: the main target language

* in the “Desk” column: the currently active console in this booth

* inthe “A/B” column: the channel (A or B) used by the interpreter

* in the “Act. lang.” column: the current target language

* in the “Autofloor” column: whether the "“Auto-floor” function is enabled
* in the “Mix"” column: whether the “Mixed"” mode is active

* in the “Quality” column: the quality of the interpretation
“+" js displayed if the interpreter works directly from the source
language into the target language
“-""is displayed if the interpreter works from a colleague's interpretation
(e.g. "Auto-floor”)

* in the "Relay” column: whether one of the RELAY keys is pressed on the
corresponding console

The “Desk’ overview displays:

* in green:
the active interpreter consoles in the corresponding booth

* ingray:
interpreter consoles which are not detected by the system or which are
not initialized correctly
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fndern B-Kanal

{ Desk 2
T

82 English
83 French
84 Italian
85 Spanish
86 Dutch

87 .Japanese
88 Russian k

Changing the language for the B-channel of an
interpreter console during the conference

To change the language for the B-channel of an interpreter console during
the conference:

Click the “Update’” on the menu bar or click the “Update” button in the
“Interpreter Management” window.
The “Update B Channel” window opens.

Update B Channel : MEGA
rDesks - B Channel

Channel Language
101 Gomman T - E
02:02 English Booth01 Save
03:03 French
04:04 ltalian Desk 1 Desk 2
05:05 Spanish = -
06:06 Dutch I J I J
Desk 3 Desk 4
Desk 5 Desk B

Exit

The “Update B Channel” window shows the booth table on the left and
all interpreter console boxes belonging to the selected booth on the
right.

In the booth table, click the booth with the interpreter console whose

B-channel configuration you want to change.

The interpreter console boxes of the selected booth appear. Interpreter

console boxes in which “Desk .." is displayed in blue represent consoles

which are initialized correctly; interpreter console boxes in which “Desk
" is displayed in gray represent consoles which are not initialized

correctly and cannot be selected.

In the desired interpreter console box, open the drop down list box.

From the drop down list box, select the language you want to assign to
the B-channel of the selected interpreter console and click the “Save”
button.

The B-channel of the selected interpreter console is configured and the
abbreviation of the assinged language appears on the display of the
interpreter console.

If some language do not appear in the drop down list box, their
selection for the B-channel has been prevented (see “Preconfiguring
the languages for the B-channel of an interpreter console” on page 97).



Upgrading the software license

Field Exchange Utilit x|
| = |

Get Locking Code |

8| &

Update Licenze |

Help |

Upgrading the software license

To upgrade the software license:
Make sure that the dongle is inserted into the correct port of your PC.

Click “Start” and select “Programs” and “SDC 8200" one after the
other. Then click “Field exchange utility".
The "“Field exchange utility” window opens.

Click the “Get Locking Code” button.
The code is displayed in the box above the button.
To save this code in a file:

Click the “Save locking code to a file” icon (_&]).

To copy the code to the clipboard:
Click the “Copy to Clipboard” icon ([&a]).

Send this code (by email or by fax) to your Sennheiser distributor.
Within five days, you will receive the new license in the form of a license
code.

Enter this license code in the box above the “Update License” button.

To avoid typing errors:

Use the “Paste from Clipboard"” icon ((&]) to paste the code received by
email and copied to the clipboard in the box.

If the new license code is saved in a file, click the “Load license code
from a file” icon ((=).

To enable the license:
Make sure that the dongle is inserted into the correct port of your PC.
Click the “Update License” button.

Close the “Field exchange utility” window and start the software.

For further information, click the “Help” button.
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Folders and file types

The two SDC 8200 programs “Confsys” and “Intsys” use the following
folders and file types:

Folders

During software installation, the two folders “s_cM" (for the data of the
conference system ) and “s_IM" (for the data of the interpretation
system) are created in the selected installation folder (preset:
“"C:\Programs\SDC8200").

In each of these two folders, a “data” subfolder is created in which you
can save your conference files.

When you create a new interpretation configuration, a subfolder with the
name of the configuration is created in the folder
“C:\Programs\SDC8200\S_IM".

File types
The software writes and reads the following file types:

* . tec

*.del

*.dia

*.1nd

* . txt

*txt

year_month_day--No_description.txt
2005_01_01--001_01_description.txt
year_month_day--No_description.vot
2005-11-11--001_01_Election of Chairperson.vot
P month day hour minutes h.minutes 1 second
P0411100.251
miclog_year_month_day_hour_minute_second.log
miclog_2005_01_01_12_59_59.log
badgelog_year_month_day hour_minute_second.log
badgelog_2005_01_01_12_59_59.1og

booth.cha

booth.par

booth.pio

booth.pre

booth.001

booth.txt

naam. txt



If problems occur...

Hit CR to abort: x|

Mo kew Found. Mount key and try again.

Waiting for master...

DOptiohs | LCloze

HErrores
Micro 0000 I &2 I

If problems occur...

If the “No Communication” dialog box appears:
See “Configuring communication with the central unit” on page 49.

See “Setting the correct starting options” on page 19.

If the “Insert dongle and try again” dialog box appears:

See “Connecting the dongle” on page 18.

If the “Waiting for master..."” dialog box appears when the program is
started for the first time:

See “Setting the correct starting options” on page 19.
If the “Waiting for master..."” dialog box appears when the program is
started for the second time or later:

See “Configuring the PCin a network” on page 44 and “Configuring the
COM port” on page 49.

Check if there are entries in the “#Errors” box of the control palette or
if consoles are displayed in yellow in the synoptic view.

Make sure that these consoles are connected correctly.

If correctly connected consoles are displayed in yellow in the synotic
view, these consoles are defective and have to be replaced.
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Accessories

SDC 8200 SYS:

Software for the SDC 8200 CU central unit,
(full version CD-ROM, dongle, software manual)

SDC 8200 SYS SW: Software for the SDC 8200 CU central unit,

(update CD-ROM, dongle, software manual)

In addition to the SDC 8200 SYS software, you require at least one of
the following software modules.

SDC 8200 S-MM:
SDC 8200 S-DM:
SDC 8200 S-VM:
SDC 8200 S-VD:

SDC 8200 S-IM:

SDC 8200 LL-8

SDC 8200 LL-28

SDC 8200 SYS-M:

S-MM (Microphone Management) software module
S-DM (Delegate Management) software module
S-VM (Voting Management) software module

S-VD (Voting Display) software module

S-IM (Interpreter Management) software module

License for 8 language channels

License for 28 language channels

Software for the SDC 8200 CU-M central unit,
incl. a dongle, the software manual and a license for
four language channels

The functionality of the SDC 8200 SYS-M software cannot be expanded
by additional licenses.
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Acoustic signals 45
triggering 81

Agenda 58
adding voting items 59
changing voting items 59
deleting voting items 61
loading 82
printing 63

Automatic Init 37

Badge Logging 47
Bell 45,81

Chairman unit
configuring before the start of the
conference 33

configuring during a conference 73

Chip card
printing the data of all chip cards

saving the data of all chip cards 79

Clear Request 73

COM port

configuring 49
Conference

starting 66
Conference console icon 30

adding 30

aligning 31

deleting 31

hiding 32

meanings of the colors 70
moving 31

Conference consoles
testing 80

Conference mode
configuring before the start of the
conference 48

Conference modet
changing during a conference 79

Confsys 10, 16

starting 22
Console icon label
adding 33
aligning 33
deleting 33
moving 33

Control palette 67
displays 67

Delegate data 51

changing 52
deleting 53
finding 53
importing 54
moving 53
printing 55

searching 53
Delete — Reserve 38
Desk Language Assignment 95

Dongle 11
connecting 18
dongle driver 16

Field Exchange Utility 16, 109
Full Init 37

Grid lines 31

Gruppen
Definieren 34

Important features of the software

Initialization
automatic 37

changing an assigned microphone number

checking 39

conference consoles 37

manual 37
Initializing

automatically 37

changing an assigned microphone numbe
changing an assigned microphone number

checking 39
conference consoles 37
interpreter consoles 101
manually 37

Interpretation configuration

creating 93
deleting 95
opening 94

Interpreter booths
assigning languages 95

assigning the target language for the

A-channel 96

8

38

38
38
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Interpreter console

changing the language for the B-channel during

the conference 108
preconfiguring languages for the B-channel

Interpreter consoles
displaying the serial number 104
initialization 101
monitoring the status 107

Interpreter Manangement software
locking 101

IntSys 10, 16
starting 92

Language table 96

Licences
upgrading 109

Licenses 11

Micro Logging 47
Microphone Management 10

Name list 67
Open Init 38
Options

Confsys 40

automatically saving data 47
Autosave 42

COM port 49

Logo 43

Max MicroON 49

menu language 44

Mode 48
Presences 43
protocol 47

saving options 50

Vote Mode 42

Votetext 43
IntSys 100

COM port 100

menu language 100

Password
changing 21
Confsys
Password1 12
Password 2 12
IntSys 100
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Path copy 47
Path data 47

Request to speak
rejecting all requests to speak 73

RS 232 interface 13, 15

Screen resolution 13
Serial interface 13, 15

Software module 9
Delegate Management 10
Interpreter Management 11
Voting Display 11
Voting Management 10
Speaker limit
configuring 49
Start Voting 88
Stop Voting 89
Synoptic view 23, 66
closing 24
creating 23
meanings of the colors of the console icons
opening 24
saving 24

Test Generator ON 80

Text messages
sending to interpreter consoles 105

Tool palette 67

Volume 74
Vote 82

Voting
configuring 58
creating an agenda 58
ending a vote 89
repeating a vote 90
starting a vote 88
taking a vote 82

Voting items
importing 62
moving 62
Voting settings 84
lof3 85
lof5 85
automatically printing 85
Badge 84
chipcards 84
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Printer 85
Real Time Voting 85
Secret 84

secret/public 84
Vote Mode 85
voting mode 85
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